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Who Should Read This Guide?
This guide is intended for systems administrators who are configuring, managing, and
deploying Teradici PCoIP® Remote Workstation Card firmware with release 5.1.

Administrators are expected to have experience configuring PCoIP clients, and have a
working knowledge of the PCoIP protocol and networking principals.

Note: Understanding terms and conventions in Teradici guides
For information on the industry specific terms, abbreviations, text conventions,
and graphic symbols used in this guide, seeUsing Teradici Product and
Component Guides and the Teradici Glossary.
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Using This Guide
This guide explains how to configure Teradici PCoIP® Remote Workstation Card
firmware release 5.1. This guide describes your Teradici PCoIP® Remote Workstation
Cards capabilities, and explains how to set up, configure, and manage your Teradici
PCoIP® Remote Workstation Card. It also answers frequently asked questions.

Use the following list for quick access to the topics covered in this guide:

l Who Should Read This Guide? on page 6 Outlines the document's intended
readers, describes what's new in Teradici PCoIP® Remote Workstation Card 5.1
and how to use the guide, establishes document conventions, and lists
additional resources you may find useful.

l Introducing Your PCoIP Remote Workstation Card on page 11 Describes how
to set up your Teradici PCoIP® Remote Workstation Card, and outlines what you
need to do to secure the Teradici PCoIP® Remote Workstation Card.

l About the PCoIP Administrative Web Interface (AWI) on page 23 Describes the
main administrative tool of the PCoIP Remote Workstation Card

l Configuration Parameters on page 29 Describes parameters you can configure
using your Teradici PCoIP® Remote Workstation Card's Administrative Web
Interface (AWI), and the Teradici PCoIP Management Console.

l Installing Your Remote Workstation Card on page 14 Describes how to install
your PCoIP Remote Workstation Card in your host PC and includes references
to optional hardware and software that should be installed before a need for it
arises.

l PCoIP Remote Workstation Card Security Overview on page 60 Describes the
main security options and configurations of the Teradici PCoIP® Remote
Workstation Card that should be considered before deployment.

l Establishing a PCoIP Session to a Remote Workstation Card on page
89 Shows you how to connect to a PCoIP client, and how to disconnect from a
PCoIP session.
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Getting More Information
In addition to this guide, the PCoIP Remote Workstation Card documentation includes:

l PCoIP Remote Workstation Card Quick Start Guide
l PCoIP Remote Workstation Card firmware 5.1 Release Notes

For detailed information on using the PCoIP Management Console to manage
deployments, see the Teradici PCoIP® Management Console User Manual release
3.1 or newer.

For help using and configuring firmware for PCoIP Zero Clients, see PCoIP Zero
Client Firmware Administrators' Guide.

For information on installing and configuring additional Remote Workstation Cards
and PCoIP Zero Clients so that you can use additional monitors on your desk, see
Tera2 PCoIP® Multi-Monitor Deployment Guide.

The latest updated information is always available at Teradici Support.
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What's New in Remote Workstation Card
Firmware 5.1
PCoIP Remote Workstation Card firmware 5.1 is a firmware release for Remote
Workstation Cards only. This release includes the following improvement:

Custom Peering Certificates
Custom peer-to-peer certificates can now be added and applied to the Peer-to-Peer
Certificate field that allows for secure peer-to-peer connections between Remote
Workstation Cards and PCoIP Zero Clients (firmware 6.2 or later) that is unique to your
network. See Peering Remote Workstation Cards to Zero Clients on page 70 for
details.

Caution: Best Security Practices
Teradici highly recommends using this new feature to create a more secure
environment. Contact your IT department to ensure your deployment is in
accordance with your Company's security policy.

Related: Host Software for Windows and for Linux
Additional enhancements and features can be found by using the latest Host
Software package available for your Windows or Linux platform. You can
download the latest PCoIP software and firmware from the Teradici Support
Site.

Platforms
Remote Workstation Cards are supported on host PCs using Windows or Linux
platforms when the host PC supports PCIe x1 required to install the PCoIP remote
workstation card. Additionally, Teradici provides an optional host software package
that can be installed on the host PC. The software package called Host Software is
specific to each platform and communicates with the remote workstation card adding
additional features and performance enhancements. For more information on the Host
Software see PCoIP® Host Software for Linux Administrators' Guide and PCoIP®
Host Software for Windows User Guide.

Important: Host Software and Firmware features
Some features of the host software may require a minimum firmware version
on the PCoIP RemoteWorkstation Card and the PCoIP Zero Client. Always
review the release notes for Host Software feature requirements.
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Tip: Wacom Tablets on Linux Host PCs
Wacom tablets are currently supported when connecting to Remote
Workstation Card in a Linux PCusing Tera2 PCoIP Zero Clients with an
attachedWacom tablet. It is recommended that the latest firmware release be
used on your Tera2 PCoIP Zero Client and the latest Host Software for Linux
release be installed on your host PC. This is required to maintain local cursor
support on the zero client side, and best performance in sessions with the
RemoteWorkstation Card. Using the latest firmware and Host Software on
PCoIP endpoints will provide the most up to date support for Wacom devices
and functions when the latest Wacom drivers are used.
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Introducing Your PCoIP Remote
Workstation Card
A PCoIP Remote Workstation Card is a small add-in card that can be integrated into
tower workstations, rack mount workstations, computer blades, and server blades.
PCoIP remote workstation cards are manufactured and integrated by various display
card manufacturers, supporting widescreen formats, and are powered by TERA2220
or TERA2240 processors. The card's TERA-series processor uses advanced display
compression algorithms to encode a user's full workstation environment and then
communicated over an IP network to the user's PCoIP client endpoint. Because PCoIP
remote workstation cards do not have general purpose CPUs, local data storage, or
application operating systems, they are very secure and easy to manage. This is
separate from the host PC which do have general purpose CPUs and local data
storage. PCoIP remote workstation cards contain upgradable firmware that enables
you to customize your PCoIP Remote Workstation Card with various features.

Note: Teradici processor
The processor name refers to the chipset used in the PCoIP device. For
example, TERA2240 is the processor used in the second-generation
TERA2240 PCIe remote workstation card (for tower PC or rackmount
workstations) and TERA2240 PCI Mezzanine remote workstation card (for
blade workstations). For details on how to display the processor name for your
device, seeDisplaying Processor Information on page 95.

Supported Resolutions for PCoIP Remote Workstation Cards

Processor
Name

Maximum No. of Supported
Displays and Resolutions

Device Type Processor Family

TERA2220 2 x 1920x1200

1 x 2560x1600

remote
workstation
card

Tera2

TERA2240 4 x 1920x1200

2 x 2560x1600

remote
workstation
card

Tera2

You can mix and match any remote workstation card with any zero client. However,
when you connect a zero client endpoint to a remote workstation card, the maximum
supported resolutions for any displays attached to the endpoint will equal the highest
common denominator between the two devices. For example, if you connect a
TERA2140 zero client to a TERA2240 remote workstation card, you can attach up to
four 1920x1200 displays or two 2560x1600 displays. However, if you connect a
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TERA2321 zero client to the same remote workstation card, the options become up to
two 1920x1200 displays or one 2560x1600 display.

Advanced Encryption Standard (AES) is employed for PCoIP session encryption
supporting both AES-128-GCM and AES-256-GCM encryption. For more information,
see Security Cipher Suites on page 74.
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About the Management Tools
The following configuration and management tools are available for PCoIP Remote
Workstation Cards:

l PCoIP Administrative Web Interface (AWI): A web-based interface for
configuring a specific PCoIP Remote Workstation Card’s firmware remotely after
typing the endpoints’s IP address or FQDN into the browser’s address bar. For
more information, see About the PCoIP Administrative Web Interface (AWI) on
page 23

l PCoIP Endpoint management software: A management tool for managing
multiple PCoIP endpoints, such as PCoIP Remote Workstation Cards remotely.
Teradici's management software is the PCoIP Management Console. For
information about the PCoIP Management Console, see the latest PCoIP
Management Console Administrators’ Guide.

Important: Management Console firmware requirement
Earlier firmware releases can only be managedmyMC1.10.8. Please
review thePCoIP Management Console lifecycle page for up-to-date
information on the life status and support of earlier releases.
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Installing Your Remote Workstation Card
Using the PCoIP Remote Workstation Card requires installing the card into a PCIe slot
on the host PC motherboard, connecting the remote workstation card to the host
PC GPU, and plugging it into a DHCP enabled network with PCoIP clients connected.
Optionally, you can connect the PCoIP Remote Workstation Card power cable to the
host PC motherboard which allows the host card to turn off and wake the host PC
through wake-on-lan. Another option is to install the Host Software on the host PC to
enhance the PCoIP experience when using the PCoIP Remote Workstation Card.

Most PCoIP remote workstation cards come with DHCP enabled and will accept a
connection from any client. This allows a PCoIP connection with minimal effort when
first connected to a network with PCoIP clients. All that is required is to connect the
PCoIP remote workstation card to a network with DHCP enabled via the card's RJ45
connector.

Important: OEM default settings
PCoIP remote workstation cards default settings can be changed by
OEM manufacturers. Reference your OEM documentation to ensure a smooth
deployment.

Important: MAC address
The PCoIP remote workstation card's MACaddress is located on a sticker on
the card. It is important to write down this address before installing the card in
the workstation. see KB 1360 in the Teradici Support Site for additional
information. You will need this information to connect to the card using
SLP discovery.

Ensure the host PC is completely powered off before installing the PCoIP Remote
Workstation Card to the host PC and connecting the optional PCoIP remote
workstation card remote power cable.

l Insert the PCoIP Remote Workstation Card into an available PCIe slot and
secure the card's metal bracket.

l Connect the PCoIP remote workstation card to your network using the Ethernet
port.

l Connect the GPU to the PCoIP remote workstation card using the cables that
came with your card.
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Important: Connecting cables correctly
To get a desired resolution, all the components of your system
(workstation card, GPU, zero client, and monitors) must support this
resolution. In addition, the cablesmust be connected according to the
following rules:

o Always start with the lowest number GPUport (DisplayPort or DVI)
and work up sequentially from there, similarly connecting to the lowest
number PCoIP remote workstation card port

o For 2560x1600 resolution, you must use DisplayPort ports on the
workstation’s GPUwhen connecting to the workstation card
DisplayPort.

If you use DVI ports on the GPU, the maximum resolution supported is
1920x1200. The DVI-mDP cable shipped with the workstation card only
supports single-link data rates. This means that if you connect the first
dual-link DVI port on the GPU to a port on the workstation card, you will
still only get a single-link data rate (i.e., resolutions up to 1920x1200).

l Optionally (and recommended) install the Teradici PCoIP Remote Workstation
Card power button cable. This connection allows a remote user to power cycle
the host PC (e.g., when the operating system is non-responsive).
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l Connect the white end of the power button cable to the power button cable
connector on the PCoIP remote workstation card.

l Locate where the host PC front-panel power button cable connects to the
motherboard. Disconnect the host PC’s front-panel On/Off switch cable
from the motherboard’s header, and locate the Power On/Off signal pins.
Connect the red wire on the workstation card power button cable to the
positive terminal of the Power On/Off pin. Connect the black wire to the
negative terminal. The negative terminal is typically a ground pin.

Caution: Motherboard power pins
The location of the Power On/Off switch pins is different from one
motherboard to another. See your motherboard user manual for
details. If you have the connector inversely connected, the host PC
will not power up.

l Connect the host PC’s front-panel On/Off switch cable to the 2-pin header
on the workstation card power button cable. If this is not possible, the host
PC’s front-panel On/Off Switch is disabled.

When powered on, the host PC will be ready to receive a PCoIP connection.

PCoIP Host Software for Windows or Linux
Optionally, once the PCoIP Remote Workstation Card is installed in the host PC, you
can install the PCoIP Host Software package on the host PC/workstation to allow you
to manage the card directly from the PCoIP Host Software UI on the workstation.
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Important: Enable Host Driver Function
Before installing the host software package for Linux or Windows on the
workstation, you must first log in to the remote workstation card from the AWI,
and enable the host driver function in the firmware from theConfiguration >
Host Driver Functionmenu.

For detailed instructions on how to install the PCoIP host software, please see
PCoIP® Host Software for Windows User Guide or PCoIP® Host Software for Linux
User Guide.

Host Driver Function
When enabled, the Host Driver Function allows the PCoIP host software installed on
the host computer to communicate with the PCoIP remote workstation card. The host
software lets users enable features such as the following:

l Using the local cursor and keyboard feature
l Locking the host PC when a session is terminated
l Using the Wake-on-LAN function
l Viewing host and client network parameters
l Disconnecting a session
l Viewing host statistics and connection information
l Using the client display topology settings on the host

When disabled, you will not have access to additional features.

Tip: Identifying a PCoIP remote workstation card
On your Windows host PC, use device manager to see if a PCoIP remote
workstation card is installed. This works if the Host Driver Function is enabled.

On your Linux host PC, open the command prompt and type lspci | grep
-i tera to see if a PCoIP remote workstation card is installed.

Note: Host Driver Function not enabled
If the Host Driver function is disabled:

l the Host Software for Linux will alert you it cannot find a PCoIP remote
workstation card.

l the Host Software for Windows will not install
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Connection Requirements
This section lists basic requirements for the PCoIP Remote Workstation Card and the
following connection types you can make to the PCoIP Remote Workstation Card
using firmware 5.1. This firmware release support connections from PCoIP Zero
Clients, Teradici Software Clients and management using PCoIP Endpoint Managers
(such as the PCoIP Management Console).

l Zero Client–to–Remote Workstation Card Prerequisites
l Teradici PCoIP Software Client–to–Remote Workstation Card Prerequisites
l Configuring Discovery 3.1

Important: No-IP networks
While zero clients and remote workstation cards can be configured to be
directly connected via a no-IP network (a cable connecting both units together
with no switch in between), it is not a configuration that is supported by Teradici.
For more information see KB 1297

Info: Downloading Firmware
To download a specific firmware version for remote workstation card, log in to
the TeradiciSupport Site. You may require a TeradiciWorkstation Access
subscription to access some firmware versions.

PCoIP Remote Workstation Card Requirements
The PCoIP remote workstation card has few requirements other than being used in a
host PC that supports PCIe x1 devices. However the PCoIP remote workstation card is
of little use without a PCoIP capable client connected to it. PCoIP client requirements
are listed by the PCoIP client being used.

PCoIP Zero Client to PCoIP Remote Workstation Card
Before connecting a PCoIP Zero Client to a remote workstation card, please ensure
that the following prerequisites are in place:

l Ensure the remote workstation card and zero client have compatible firmware
versions identified in the release notes.
For information on how to assign a firmware file to a profile using the MC, see
MC: Firmware Management. For information on how to upload firmware to a
single host or client using the AWI, see Uploading Firmware.
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l The zero client and PCoIP remote workstation card are using compatible
security encryption.

l The zero client and PCoIP remote workstation card have the same Peer-to-Peer
certificate configuration. See Peering Remote Workstation Cards to Zero Clients
on page 70 for details.

l The networks between the remote workstation card and zero client are properly
configured.

l Optionally, the host PC power cable is connected if you are wanting to use the
host PC power on/off switch.

PCoIP Software Client–to–PCoIP Remote Workstation
Card
Before connecting a PCoIP software client to a remote workstation card, please
ensure:

l The PCoIP remote workstation card has a compatible firmware installed. See the
firmware release notes for compatibility details.
For details about PCoIP software client requirements, and instructions on how to
configure the client to connect to a remote workstation card, please see your
software client administrators guide.

l The Teradici software client and PCoIP remote workstation card are using
compatible security encryption.

l The PCoIP Host Software is installed on the host PC.
l The networks between the remote workstation card and zero client are properly
configured.

PCoIP Management Console to PCoIP Remote
Workstation Card
To use a PCoIP endpoint manager to remotely manage PCoIP remote workstation
cards, ensure the following requirements are met:

l The PCoIP Management Console interface is enabled (default)

Configuring Power Options
Once your PCoIP Remote Workstation Card and remote power cable is installed on
the host PC motherboard, you can configure the power settings in the AWI. There are
two selections for the Host Wake Option and only one for the Enable Wake-on-LAN
(WoL) parameter. These parameters determine how the PCoIP remote workstation
card will behave when a remote power command is issued. A prerequisite for using
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WoL is that the workstation's PCIe slot provides sufficient standby power to the host
card.

Remote Power Button: If this option is selected and you have the remote workstation
card power button cable installed, you will be able to change the host PC power state
by asserting the workstation's front panel power button.

PCIe Wake Input: If this option is selected, you will have the option to wake the host
PC by asserting the PCIe WAKEB signal.

Enable Wake-on-LAN: This parameter must be selected to provide the host PC the
option to being turned on (wakened) remotely. When the workstation is asleep or shut
down, the host card operates in low-power mode in which all functions are disabled
except WoL Magic Packet detection. In this mode, the host card monitors the network
for a WoL Magic Packet that matches its MAC address. Once the host card receives
the WoL Magic Packet, it powers on the workstation by either asserting the
workstation's front panel power button or the PCIe WAKEB signal. A prerequisite for
using either option is that the workstation's PCIe slot can provide sufficient standby
power to the host card.

Related: Activating Wake-on-LAN magic packet
PCoIP zero client users sendWake-on-LANmagic packets to the remote
workstation card by:

l pressing any key on the keyboard (only if a PCoIP session is already active)
l clicking the zero client onscreenConnect button
l by pressing the power button on the zero client (only if you installed the host
card's power button cable)

Jumpers
All external connectors on Tera2 PCoIP remote workstation cards are for diagnostic
purposes. Jumpers J15 and J25 are configurable and their functions are described
below.

The picture below shows the location of the jumpers on a Tera2 PCoIP Remote
Workstation Card.

Jumper J15 Reset Parameters
This jumper will reset parameters on the host card back to factory default settings.
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To reset:

1. Place the jumper on pins 2 and 3 on a PCoIP remote workstation card. If
installed into the host PC, ensure the host PC has no power supplied to it.

2. Power on the host PC and wait until the heartbeat pulse is visible on the PCoIP
remote workstation card. The PCoIP heartbeat LED flashes twice quickly
followed by a slight pause.

3. Power down the host PC containing the PCoIP remote workstation card.
4. Put jumper back to pin 1-2.
5. Power on the host PC.

Software Reset Parameters
Using jumper 15 is generally not required as you can reset the PCoIP remote
workstation card parameters from the AWI (Configuration > Reset Parameters).

Jumper J25 Isolated Ground
Adjustment of the ground jumper is not normally required. The power button output
from the host card is isolated so that it can be connected to the motherboard in either
polarity. Some motherboards do not work with an isolated input and thus require the
ground jumper to be installed. This is done by shorting pins 2-3 which requires the
power cable to match polarity with the motherboard pins. When left on the default
settings (pins 1-2 shorted), the polarity of the power cable is ignored as the power
button is now isolated.

LEDs
There are 4 LEDs on the back of the Tera2 PCoIP remote workstation card that serve
the same purpose on both the dual and quad cards. The 2 PCoIP LEDs show the
health of the PCoIP remote workstation card and the 2 NIC LEDs indicate the NIC
status.

l PCoIP Heartbeat Red LED has a heartbeat icon above it. This LED will normally
blink indicating normal operation

l PCoIP Status Green LED has a PCoIP icon below it. This LED will be solid
green when in session.

l NIC RJ45 Green LED indicates network activity. This LED blinks during network
activity indicating normal operation.
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l NIC RJ45 Yellow LED indicates the connections state. This LED is solid when a
network connection is established.
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About the PCoIP Administrative Web
Interface (AWI)
The PCoIP Administrative Web Interface (AWI) enables you to interact with a PCoIP
endpoint. From the AWI, you can manage and configure an endpoint, view important
information about it, and upload firmware and certificates to it.

After you type the device’s IP address or FQDN into Microsoft Edge, Mozilla Firefox, or
Google Chrome browser, the browser will use HTTPS to connect to the device’s AWI
web page. Access to the AWI is controlled using an administrative password, which
can be optionally disabled.

The AWI’s HTTPS connection is secured using a PCoIP root Certificate Authority
(CA) certificate. To avoid warning messages when you log into the AWI, it is
recommended that you install this certificate in your browser. The certificate file
(cacert.pem) is always included in a firmware release, but you can also download it
directly from How do I install the PCoIP Root Certificate in my Browser for secure
access the Administrative Web Interface? (KB 15134-529). Detailed instructions on
how to install the certificate are also included in the KB.

The following browsers are supported in this release:

l Firefox: current version
l Chrome: current version
l Microsoft Edge: current version

AWI Menus
The AWI has five main menus that link to the various configuration and status pages.

l Configuration: The pages under this menu let you configure the various aspects
for the device, such as network settings, language, session parameters, etc.

l Permissions: The pages under this menu let you set up the permissions for USB
on the client and host.

l Diagnostics: The pages under this menu help you troubleshoot the device.
l Info: The pages listed this menu let you view firmware information and the
devices currently attached to the device.

l Upload: The pages under this menu let you upload a new firmware version, an
OSD logo, and your certificates to the device.

The following figure shows the menus and pages available in the AWI.
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AWI Menu Overview

Logging into the AWI
To log into the Administrator Web Interface web page for a PCoIP Remote Workstation
Card.

1. Using a web browser, enter the PCoIP remote workstation card's IP address in
the address bar. According to network requirements, this address may be either
a static or dynamic address as follows:

l Static IP Address: The IP address is hard-coded and must be known.
l Dynamic IP Address: The Dynamic Host Configuration Protocol (DHCP)
server dynamically assigns the IP address. You can get it from the DHCP
server.

2. From the Log In page, enter the administrative password. The default value is
blank.
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Important: OEM default settings
PCoIP remote workstation cards default settings can be changed by
OEM manufacturers. Reference your OEM documentation to ensure a
smooth deployment.

AWI Log In Page

3. To change idle timeout (the time after which the user is automatically logged off),
select an option from the Idle Timeout drop-down menu.

4. Click Log In.

Note: Some PCoIP devices do not require a password to log in
Some PCoIP devices have password protection disabled and do not
require a password to log in. You can enable password protection for
these devices from the MCsSecurity Configuration page.

If configured in the firmware defaults, the Initial Setup page appears the first time you
log in. You can configure audio, network, and session parameters on this page. After
you click Apply, the Home page appears for each subsequent session. This page
provides an overview of the device status.

If a warning message appears when you try to log in, then a session is already in
progress on that device. Only one user can log into a device at one time. When a new
user logs in, the current session is ended and the previous user is returned to the Log
In page.

Passwords
The Password page lets you update the local administrative password for the device.
You can access this page from the Options > Password menu. The password can be
a maximum of 20 characters.
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Caution: Unknown AWI password
Take care when updating the client password as the client may become
unusable if the password is lost.

Note: Contact your manufacturer for your devices AWI password
Contact your manufacturer to obtain the default password for your device’s
AWI.

AWI Home Page
The AWI Home page displays a statistics summary for the PCoIP endpoint. You can
display the Home page at any time by clicking the Home link at the top left section of
the menu bar.
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AWI: Home Page

The previous figure shows session statistics for devices that can support two
connected displays. If your deployment only supports two displays, information for
these two displays will appear in the bottom area of the page.

AWI Home Page Statistics

Statistics Description

Processor PCoIP processor type, version, and RAM size

Time Since Boot Length of time that the PCoIP processor has been running.

PCoIP Device Name The logical name for the device.

This field is the name the endpoint registers with the DNS server
if DHCP is enabled or the system is configured to support
registering the hostname with the DNS server. (See thePCoIP
Device Name parameter on the Label page.)

Connection State The current state of the PCoIP session. Values include the
following:

l Asleep
l Canceling
l Connected
l Connection Pending
l Disconnected
l Waking

Connection Duration Displays the length of time the device has been connected to a
host endpoint.

802.1X
Authentication Status

Indicates whether 802.1x authentication is enabled or disabled
on the device.

Session Encryption
Type

The type of encryption in use when a session is active:

l AES-128-GCM
l AES-256-GCM

PCoIP Packet
Statistics

PCoIP Packets Sent: The total number of PCoIP packets sent
in the current/last session.

PCoIP Packets Received: The total number of PCoIP packets
received in the current/last session.

PCoIP Packets Lost: The total number of PCoIP packets lost in
the current/last session.
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Statistics Description

Bytes Bytes Sent: The total number of bytes sent in the current/last
session.

Bytes Received: The total number of bytes received in the
current/last session.

Round Trip Latency Theminimum, average, andmaximum round-trip PCoIP system
and network latency in milliseconds (+/- 1 ms).

Bandwidth Statistics Transmit Bandwidth: Theminimum, average, andmaximum
traffic transmitted by the Tera processor. The active bandwidth
limit is the maximum amount of network traffic the Tera
processor may currently generate. The value is derived from the
configured bandwidth parameters and the current (or last)
network congestion levels.

Receive Bandwidth: Theminimum, average, andmaximum
traffic received by the Tera processor.

Pipeline Processing
Rate

How much image data is currently being processed by the image
engine (in megapixels per second).

Endpoint Image
Settings In Use

Displays if the image settings being used are configured within
the client or within the host. This is based on how theUse Client
Image Settings field is configured on the Image page for the
host device.

Initial Image Quality Theminimum andmaximum quality setting is taken from the
Image page for the device.

The active setting is what’s currently being used in the session
and only appears on the host.

Image Quality
Preference

This setting is taken from the Image Quality Preference field
on the Image page. The value determines if the image is set to a
smoother versus a sharper image.

Build to Lossless Options that may appear in this field include the following:

Enabled: TheDisable Build to Lossless field on the Image
page is unchecked.

Disabled: TheDisable Build to Lossless field is checked.

Display The port number for the display.
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Statistics Description

Maximum Rate This column shows the refresh rate of the attached display.

If theMaximum Rate field on the Image page is set to 0 (i.e.,
there is no limit), the maximum rate is taken from themonitor's
refresh rate.

If theMaximum Rate field on the Image page is set to a value
greater than 0, the refresh rate shows as "User Defined."

Input Change Rate The rate of content change from the GPU. This includes
everything the user is doing (such as cursor movement, email
editing, or streaming video).

Note: This option is only available on the host. It does not appear
on the client.

Output Process Rate The frame rate currently being sent from the image engine on the
host to the client.

Initial Image Quality Shows the current lossless state of the attached display:

l Lossy
l Perceptually lossless
l Lossless

Note: Clicking Reset Statistics also resets statistics on Home page
When you click theReset Statistics button on a remote workstation card
Session Statistics page, the statistics reported in the Home page are also reset.

Configuration Parameters
This section provides descriptions for the parameters found within each menu
selection. These parameters control the performance and behavior of your PCoIP
remote workstation card. The descriptions will help you configure and optimize your
PCoIP remote workstation card for your deployment. Some of the menu parameters
are described in a grouped section of the guide:

l Configuring Power Options on page 19
l About USB Settings on page 83
l Host Driver Function on page 17
l Software Reset Parameters on page 21

Configuring the Initial Setup
Connecting to a PCoIP Remote Workstation Card is easy right out of the box. Default
settings include enabling DHCP, SLP Discovery, DNS SRV Discovery and Accept
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Any Client allow easy setup for many networks. For simplicity, basic network and
audio settings are available on the Initial Setup page of the AWI. You can access this
page from the Configuration > Initial Setup menu.

Initial Setup Page

Audio
The two audio parameters for audio on the Initial Setup page will allow audio from a
device attached to a zero client be played from the host PC. These are the same
parameters found in the separate Audio page

Enable HD Audio allows the audio hardware on the zero client to be used when
connecting to a PCoIP remote workstation card. When disabled, the audio hardware is
not available for the host operating system to enumerate.

Enable Audio Line In allows the use of the line-in connector on a zero client so an
audio device can be plugged into a zero client and played on the host PC. When
disabled you can use the line-in connector as a microphone input.
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Info: Microsoft Windows Vista/7/8 users
If using Microsoft® Windows Vista®/7/8, please ensure you do the following for
this feature to function correctly:

1. Run regedit.
2. Search the registry keys for PinConfigOverrideVerbs and delete these

registry entries.

Network
the Network parameters on the Initial Setup page allows you to enable DHCP or
manually configure network settings, allowing you to connect to your network quickly.
For more detailed network configurations, see Configuring Host Network Settings on
page 31 where you will have additional options.

Session
Accept Any Client allows any PCoIP zero client or PCoIP software client to connect to
the PCoIP remote workstation card. If your deployment requires a connection from a
specific client, you have the option of entering its MAC address here. For more secure
settings when connecting from a PCoIP client, see Configuring a Session on page 47.

Configuring Host Network Settings
This page lets you configure network settings for the PCoIP remote workstation card.
You can access this page from the Configuration > Network menu. After you update
the parameters on this page, click Apply to save your changes.

You can also configure network information from the host's Initial Setup page.
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AWI Network Page Parameters

Parameter Description

Enable DHCP When enabled, the device contacts a DHCP server to be
assigned an IP address, subnet mask, gateway IP address, and
DNS servers, and also requests a domain name (option 15), host
name (option 12), and client fully qualified domain name (FQDN).

When disabled, youmust set these parameters manually.

IP Address The device's IP address. If DHCP is disabled, youmust set this
field to a valid IP address. If DHCP is enabled, you cannot edit
this field.

Subnet Mask The device's subnet mask. If DHCP is disabled, youmust set
this field to a valid subnet mask. If DHCP is enabled, you cannot
edit this field.

Warning: It is possible to configure an illegal IP address/subnet
mask combination (e.g., invalid mask) that leaves the device
unreachable. Take care when setting the subnet mask.
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Parameter Description

Gateway The device's gateway IP address. If DHCP is disabled, this field
is required. If DHCP is enabled, you cannot edit this field.

Primary DNS Server The device's primary DNS IP address. This field is optional. If
the DNS server IP address is configured when using a
connection manager, the connection manager address may be
set as an FQDN instead of an IP address.

Secondary DNS
Server

The device's secondary DNS IP address. This field is optional. If
the DNS server IP address is configured when using a
connection manager, the connection manager address may be
set as an FQDN instead of an IP address.

Domain Name The domain named of the device (e.g., "domain.local"). This field
is optional.

FQDN The fully qualified domain name for the device. The default is
pcoip-host-<MAC> or pcoip-portal-<MAC> where <MAC> is the
device's MAC address. If used, the domain name is appended
(for example, pcoip-host-<MAC>.domain.local). This field is
read-only on this page.

Note: To use the FQDN feature, the DNS server with DHCP
option 81must be available and properly configured.
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Parameter Description

Ethernet Mode Lets you configure the Ethernet mode of the device as follows:

l Auto
l 100 Mbps Full-Duplex
l 10 Mbps Full-Duplex

When you choose 10 Mbps Full Duplex or 100 Mbps Full-
Duplex and then click Apply, the following warning message
appears:

"Warning: When Auto-Negotiation is disabled on the PCoIP
device, it must also be disabled on the switch. Additionally, the
PCoIP device and switch must be configured to use the same
speed and duplex parameters. Different parameters may result
in a loss of network connectivity. Are you sure you want to
continue?"

Click OK to change the parameter.

Note: You should always set the Ethernet mode toAuto and
only use 10 Mbps Full-Duplex or 100 Mbps Full-Duplex when
the other network equipment (e.g., a switch) is also configured to
operate at 10Mbps full-duplex or 100Mbps full-duplex. An
improperly set Ethernet modemay result in the network
operating at half-duplex, which is not supported by the PCoIP
protocol. The session will be severely degraded and eventually
dropped.

Enable Gigabit Auto-
Negotiation

Lets you select the maximum negotiated speed of the network
interface.

When enabled (the default), the maximum possible speed is 1
Gbps. When disabled, it is 100Mbps.

Note: Youmay want to disable this feature on the host card if
you are experiencing Ethernet packet loss (which can result in
loss of network connectivity and PCoIP session loss). This
scenario can be caused by Ethernet cabling that is not up to
Gigabit Ethernet specification (e.g., old building wiring
composed of Cat5 cable). Out-of-specification cable will often
still successfully auto-negotiate to 1 Gbps speed, but may
subsequently have CRC errors during normal operation.
Disabling Gigabit Auto-Negotiation prevents the network
interface from advertising to its peer on the network that it
supports Gigabit Ethernet operation, and so themaximum
possible negotiated speed drops to the next level (100Mbps).
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Parameter Description

Prefer Master for
Auto-Negotiation

When enabled, this setting makes the remote workstation card
themaster for auto-negotiation. It can be used when a client is
connected directly to a remote workstation card without an
intervening switch.

MaximumMTU Size Lets you configure theMaximum Transfer Unit packet size.

A smaller MTU may be needed for situations such as VPN
tunneling because PCoIP packets cannot be fragmented. Set
theMaximumMTU Size to a value smaller than the network
path MTU for the end-to-end connection between the host and
client.

TheMaximumMTU Size range is 600 to 1500 bytes for all
firmware versions. The default MTU size is 1200.

Enable 802.1X
Security

Enable this field for each of your devices if your network uses
802.1x security to ensure that only authorized devices access
the network. If enabled, configure theAuthentication, Identity,
andClient Certificate fields.

Authentication This field is set to TLS (Transport Layer Security) and is grayed-
out. TLS is currently the only authentication protocol supported.

Identity Enter the identity string used to identify your device to the
network.

Client Certificate Click Choose to select the client certificate you want to use for
your 802.1x devices. The list of certificates that appears
includes the certificates uploaded from theCertificate Upload
page that contain a private key. The certificate you choose from
theNetwork page is linked to the read-only Client Certificate
field on theCertificate Upload page.

Note: PCoIP only supports one 802.1x client certificate. Ensure
your security details are all contained within the one file. The
802.1x certificate must contain a private key.

Enable 802.1X
Support for Legacy
Switches

When enabled, allows greater 802.1x compatability for older
switches on the network.

Configuring IPv6 Settings
The settings on this page let you enable IPv6 for PCoIP devices connected to an IPv6
network.

You can access this page from the Configuration > IPv6 menu.
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AWI IPv6 Page

Important: Reboot
When youmake a change to one of the settings on this page, you must reboot
your device for the change to take effect.

AWI IPv6 Page Parameters

Parameter Description

Enable IPv6 Enable this field to enable IPv6 for your PCoIP devices.

Link Local Address This field is automatically populated.

Gateway Enter the IPv6 gateway address.

Enable DHCPv6 Enable this field to set up Dynamic Host Configuration Protocol
version 6 (DHCPv6) for your device.

DHCPv6 Addresses When DHCPv6 is enabled and the device is rebooted, the server
automatically populates these fields with addresses for the
device.
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Parameter Description

Primary DNS The device's primary DNS IP address. If DHCPv6 is enabled,
this field is automatically populated by the DHCPv6 server.

Secondary DNS The device's secondary DNS IP address. If DHCPv6 is
enabled, this field is automatically populated by the DHCPv6
server.

Domain Name The domain name used (e.g., "domain.local") for the host or
client. If DHCPv6 is enabled, this field is automatically
populated by the DHCPv6 server.

FQDN The fully qualified domain name for the host or client. If DHCPv6
is enabled, this field is automatically populated by the DHCPv6
server.

Enable SLAAC Enable this field to set up Stateless Address Auto-configuration
(SLAAC) for your devices.

SLAAC Addresses When SLAAC is enabled and the device is rebooted, these fields
are automatically populated.

Enable Manual
Address

Enable this field to set up amanual (static) address for the
device.

Manual Address Enter the IP address for the device.

Configuring the Management State
The PCoIP Remote Workstation Card can be managed by an endpoint managers
such as the PCoIP Management Console should one be available on the network.
The AWI Management page tells the host card how to find the manager based on
predetermined network deployment security levels. Configuring the security levels for
endpoint managers is described in Configuring Endpoint Management Discovery
Methods on page 42 with further information on certificates required for each level of
secure configuration found in the PCoIP Remote Workstation Card Security Overview
on page 60

From the AWI, you can set the PCoIP Remote Workstation Card's management state
to automatic or manual modes.
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AWI Management page – automatic discovery mode

AWI Management page – manual discovery mode

Clearing the Management State
Setting Default AWI Management Console

Clear Management State (a button) --

Clearing the management state removes the current endpoint manager information for
the PCoIP remote workstation card. Once the remote workstation card is managed by
an endpoint manager, you must clear its management state before the pcoip device
can accept a new endpoint manager.

You clear the management state from the AWI Management pages.

Info: Discovery settings determine what displays on the AWI
Management page
The information that displays on the AWI Management page depends on
whether the PCoIP remote workstation card uses automatic or manual
discovery.
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To clear the management state:

1. From the OSD or AWI, select Configuration > Management.
2. From the OSD or AWI Management page, click Clear Management State so that

the endpoint will accept a new endpoint manager.
3. To save your updates, click OK from the OSD, or click Apply from the AWI.

Configuring Audio Settings
The Audio page lets you configure audio options for the PCoIP device. You can
access this page from the AWI Configuration > Audio menu.

Note: After configuring the desired options, click Apply and then Continue to have your
changes take effect.

The Audio settings allow audio from an audio device attached to a zero client be
played on the host PC operating system.

AWI Host Audio Page

Audio settings on a PCoIP remote workstation card work in tandem with the audio
settings on a PCoIP zero client. The parameters below further describe how audio
works between the two devices.

Audio Page Parameters

Parameter Description

Enable Audio When enabled, configures audio support on the PCoIP device.

Note: This property must be enabled on both the PCoIP remote
workstation card and the zero client.

When disabled, the audio hardware is not available for the host
operating system to enumerate.
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Parameter Description

Enable Audio
Line In

Determines the input mode the audio system advertises to the host
operating system. When enabled, the line-in connector found on the
client is used as a standard line-in input. When disabled, the line-in
connector found on the client is used as amicrophone input.

Note: Follow the onscreen instructions if you haveWindows 7 or 10
installed on the device.

Configuring the Label Settings
The Label page lets you assign a device name to your PCoIP device for easy
reference. You can access this page for the host card from the Configuration > Label
menu.

AWI Label Page Parameters

Parameter Description

PCoIP Device Name Lets you give the host a logical name. The default is pcoip-host-
<MAC>, where <MAC> is the device's MAC address.

This field is the name the host registers with the DNS server if
DHCP is enabled and the system is configured to support
registering the hostname with the DNS server.

It's important to ensure that thePCoIP Device Name is unique
for each endpoint in the network and follows these naming
conventions:

l The first and last character must be a letter (A-Z or a-z) or a
digit (0-9).

l The remaining characters must be letters, digits, hyphens, or
underscores.

l The length must be 63 characters or fewer.
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Parameter Description

PCoIP Device
Description

A description of the device or other information, such as the
location of the device's endpoint.

Note: The firmware does not use this field. It is provided for
administrator use only.

Generic Tag Generic tag information about the device.

Note: The firmware does not use this field. It is provided for
administrator use only.

Configuring Access Settings
The Access page lets you prevent the PCoIP device from being managed by the MC
(or any other PCoIP device management tool), and lets you disable administrative
access to the device's AWI. It also provides an option to force an administrative
password change the next time the AWI is accessed.

You can access this page from the Configuration > Access menu.

AWI Access Page

These options can also be configured from the PCoIP Management Console 3.1 or
newer.
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Caution: Enable at least one of the configuration interfaces
At least one of the device's management configuration interfaces (AWI or MC)
must remain enabled at all times. If you disable both management interfaces
you will lose the option to perform a software parameter reset should you want
to reuse the PCoIP remote workstation card in another deployment. You will be
left having to do a hardware jumper parameter reset to regain administrative
access to your PCoIP remote workstation card

When the Disable Management Console Interface is checked, the management
console interface on the PCoIP remote workstation card cannot be accessed or
managed by the MC (or any other PCoIP device management tool).
When checked, the Disable Administrative Web Interface on the PCoIP remote
workstation card cannot be accessed or managed using the AWI.
The Force password change at next login causes the administrative password on the
AWI to be changed the next time the AWI is accessed. The new password may be
blank.

Configuring Endpoint Management Discovery Methods
From the AWI Management page, you can set the PCoIP Remote Workstation Cards
security level and discovery method. See About PCoIP Remote Workstation Card
Management Security Levels on page 64.

There are several ways to register your PCoIP Remote Workstation Card with an
endpoint manager such as the PCoIP Management Console. These methods are
outlined next.

The methods include:

l Automatic Endpoint Manager Discovery Using DNS on page 43
l Configuring Endpoints for Auto Discovery Using DHCP

l Discovering the PCoIP Endpoint Manually from the Endpoint Manager on page
43

l Discovering the Endpoint Manager Manually from the PCoIP Endpoint Using
Low or Medium Security Mode on page 44

l Discovering the Endpoint Manager Manually from the PCoIP Remote
Workstation Card Using High Security Mode on page 45

The availability of these methods are determined by the PCoIP Remote Workstation
Card‘s security settings, and whether or not the host card has a certificate installed to
trust the endpoint manager.
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Automatic Endpoint Manager Discovery Using DNS
PCoIP Remote Workstation Cards can use DNS to automatically find an endpoint
manager. To use automatic endpoint manager discovery, you must configure the
environment for DNS service record discovery, and the PCoIP Remote Workstation
Card's security level must be set to low or medium.

Caution: Medium or high security requires an installed certificate
In order to use medium or high security, the PCoIP RemoteWorkstation Card
must have been provisioned with a certificate.

Resource: DNS server configuration information
For details about how to configure your DNS server for automatic discovery,
see the PCoIP®Management Console 3.1 Administrators’ Guide.

To configure the PCoIP Remote Workstation Card for automatic endpoint discovery:

1. From the AWI, select Configuration > Management. The AWI Management
page displays.

2. Set the Security Level option to Low or Medium.

Caution: Medium security level
When set to medium security, the MC certificate (leaf, intermediate, or
root) must be in the endpoint certificate store

3. Set the Manager Discovery Mode option to Automatic.
4. Click Apply.

After the PCoIP Remote Workstation Card discovers the endpoint manager, the
automatic discovery results appear on the Management page in the Discovery
Information section.

Related: Configuring your system for automatic discovery
For information about how to configure your system for automatic discovery
from the PCoIP Management Console, see the PCoIP®Management Console
3.1 Administrators’ Guide.

Discovering the PCoIP Endpoint Manually from the Endpoint
Manager
Endpoint managers, such as the PCoIP Management Console, can be used to
discover endpoints like the PCoIP Remote Workstation Card. This discovery requires
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configuration on both the PCoIP Remote Workstation Card and the endpoint manager.

To configure the PCoIP Remote Workstation Card to be discoverable by an endpoint
manager:

1. From the AWI, select Configuration > Management. The AWI Management
page displays.

2. Set the Security Level option to Low.
3. Set the Manager Discovery Mode to Automatic.
4. Click Apply.

This configuration allows an endpoint manager the ability to discover the
PCoIP Remote Workstation Card. Once discovered, the endpoint manager topology
appears on the PCoIP Remote Workstation Card Management page.

Related: Initiating discovery from the PCoIP Management Console
For more information about initiating discovery from the PCoIP Management
Console, see the PCoIP®Management Console 3.1 Administrators’ Guide.

Discovering the Endpoint Manager Manually from the
PCoIP Endpoint Using Low or Medium Security Mode
In low or medium security modes, you can manually discover the endpoint manager by
manually providing the URI for its bootstrap server.

Caution: Manual discovery requires a certificate
Whenmanual discoverymode is used, DNS cannot be used to trust the
endpoint. An endpoint such as the PCoIP RemoteWorkstation Card must have
been previously provisioned with a certificate.

To configure a PCoIP Remote Workstation Card with an endpoint manager in low or
medium security mode:

1. From the AWI, select Configuration > Management. The AWI Management
page is displayed.

2. Set the Security Level option to Low or Medium.

3. Set the Manager Discovery Mode to Manual.
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4. In the Manual Discovery section, type the bootstrap server’s URI.

Note: Bootstrap server URI must use a secured WebSocket
prefix
URIs are in this format and require a securedWebSocket prefix:

wss://<internal EM IP address/FQDN>[:port number]

The PCoIP Management Console’s listening port is 5172. If you omit the
port number, port 5172 will be used by default.

5. Click Apply.

After the PCoIP Remote Workstation Card discovers the endpoint manager, the
endpoint manager topology appears on the PCoIP Remote Workstation Card
Management page.

Discovering the Endpoint Manager Manually from the
PCoIP Remote Workstation Card Using High Security Mode
In high security mode, automatic discovery is disabled entirely; you must register the
PCoIP Remote Workstation Card manually with the endpoint manager from the
endpoint.

Caution: Manual discovery requires a certificate
Whenmanual discoverymode is used, DNS cannot be used to trust the
endpoint manager. The PCoIP RemoteWorkstation Card must have been
previously provisioned with a certificate from an endpoint manager or from the
AWI.

To configure a PCoIP Remote Workstation Card with an endpoint manager using
high security mode:

1. From the AWI, select Configuration > Management. The AWI Management
page displays.

2. Set the Security Level option to High.

3. In the Endpoint Manager URI for Direct Connect section, find the Internal URI
field and type the endpoint manager’s URI. You can also provide an external
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URI, if needed.

Note: Endpoint manager URI must use a secured WebSocket
prefix
URIs are in this format and require a securedWebSocket prefix:

wss://<internal EM IP address/FQDN>[:port number]

The PCoIP Management Console’s listening port is 5172. If you omit the
port number, port 5172 will be used by default.

4. Click Apply.

After the PCoIP Remote Workstation Card discovers the endpoint manager, the
endpoint manager topology appears on the Management page.

Configuring SNMP
SNMP stands for Simple Network Management Protocol and allows an administrator
to monitor hardware and software endpoints through an SNMP agent. The agent can
be enabled on the device you are monitoring, and a monitoring station can then view
the data. Teradici has provided a MIBv2 for download to help collect PCoIP related
data on the PCoIP Remote Workstation Card. Access to the SNMP agent is provided
by the Community Name.

Important: Community Name
When enabling the SNMP agent, consider changing the Community Name
from the default to another name of your choice.

Info: SNMP Agent
For more information on using the PCoIP SNMP Agent, seeUsing SNMP with
a PCoIP® Device User Guide.

SNMP Management Locations

Setting Default AWI Management Console

Enable SNMP Disabled

Community Name public

From the AWI SNMP page, you can enable or disable the device’s SNMP agent.
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AWI SNMP page

Related Information: PCoIP SNMP Agent
 For more information on using the PCoIP SNMP Agent, seeUsing SNMP with
a PCoIP® Device User Guide.

To configure SNMP settings:

1. From the AWI, select Configuration > SNMP.
2. From the AWI SNMP page, do the following:

l Select or clear the Enable SNMP check box.
When enabled, the device enables the PCoIP SNMP agent to respond to
SNMP requests. Disabling the SNMP agent prevents it from responding to
SNMP requests and from generating traps. It also ensures that the PCoIP
SNMP MIB cannot be accessed.

l For Community Name, enter the SNMP community name used by the
device.

3. Click Apply.

Configuring a Session
The Session page on the AWI allows you to configure how a PCoIP remote
workstation card accepts connections from peer devices. The available connection
options depend on two parameters—Accept Any Peer and TLS Security Mode. The
Differentiated Services Code Point (DSCP) option allows network administrators the
ability to prioritize PCoIP traffic within their networks, which can also boost
PCoIP network performance.

TER1206003/ 47

PCoIP® RemoteWorkstation Card Firmware 5.1 Administrators' Guide

https://techsupport.teradici.com/link/portal/15134/15164/Download/2127
https://techsupport.teradici.com/link/portal/15134/15164/Download/2127


Accept Any Peer

When enabled this parameter allows compatible clients to connect to the PCoIP
remote workstation card. Deselecting this setting requires you know the MAC address
of a client to peer with the host card.

TLS Security Mode and Encryption Ciphers

The PCoIP data stream is always encrypted, however the PCoIP remote workstation
card and client must have compatible security modes to connect. Suite B: TLS 1.2 with
Suite B-compliant 192-bit elliptic curve encryption offers an additional certificate option
which must match the configuration on the connecting zero client. The Suite B option
offers the peer-to-peer certificate option for added security. The endpoints will attempt
to use the strongest cipher first. You may select either AES-256-GCM or AES-128-
GCM ciphers, however enabling both offer more flexibility.
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Tip: Blacklisted Cipher Suites
The Blacklisted Cipher Suites offer maximum flexibility but should not be used if
possible.

The blacklist cipher suites allow an administrator the ability to disable the use of
certain cipher suites due to any security concerns. The blacklist allows you to
protect your system without requiring a firmware update. At least one cipher
suite must remain enabled at all times.

Differentiated Services Code Point (DSCP)

DSCP provides PCoIP prioritization capability to compatible network devices,
allowing for improved network performance on congested networks.

Session Parameter Options

Parameter Description

Accept Any Peer When enabled, the host accepts connections from any client.
When disabled, youmust specify the MAC address of the peer
you want the host to accept.

Peer MAC Address Enter the MAC address of the client that is allowed to connect to
the host. If theAccept Any Peer option is enabled, this field is
not required and not editable.

TLS Security Mode

(Session Negotiation
Cipher)

Configure the Transport Layer Security (TLS) cipher to use for
negotiating the TLS session between the PCoIP client and the
PCoIP host.

l Maximum Compatibility: TLS 1.1 with RSA keys. This
option provides maximum compatibility.

l Suite B: TLS 1.2 with Suite B-compliant 192-bit elliptic
curve encryption. This option provides a higher level of
security and offers the option of applying a zero client peer-
to-peer certificate.
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Parameter Description

Blacklisted Cipher
Suites

The blacklist cipher suites allow an administrator the ability to
disable the use of certain cipher suites due to any security
concerns. The blacklist allows you to protect your system
without requiring a firmware update. At least one cipher suite
must remain enabled at all times.

l TLS_RSA_WITH_AES_256_GCM_SHA384
l TLS_RSA_WITH_AES_128_GCM_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA256
l TLS_RSA_WITH_AES_128_CBC_SHA256:
l TLS_RSA_WITH_AES_256_CBC_SHA
l TLS_RSA_WITH_AES_128_CBC_SHA

PCoIP Data
Encryption Ciphers:

(Enabled Session
Ciphers)

The enabled encryption modemust match between the host and
client for a session to be established. If more than onemode is
enabled on both endpoints, the firmware selects the most secure
matching encryption enabled

l AES-256-GCM : A more secure encryption method
implemented in second-generation Tera2 processors that
offers the best security and performance between hardware
endpoints.

l AES-128-GCM: AES-128-GCMmay offer improved
performance for some deployments if there is more than 7
Mbps available bandwidth.

Enable DSCP When enabled, the device populates the Differentiated Services
Code Point (DSCP) field in the IP header, allowing intermediate
network nodes to prioritize PCoIP traffic accordingly.

Enable Transport
Congestion
Notification

When enabled, transport congestion notification is enabled to
allow PCoIP endpoints to react accordingly if an intermediate
network node sets the congestion notification bit in either the IP
header or PCoIP transport header.

Note: For more information about the PCoIP transport header,
seePCoIP Packet Format.

Configuring Session Bandwidth
From the AWI Bandwidth page (shown next), you can control the bandwidth that your
PCoIP Remote Workstation Card uses during a PCoIP session. The following
parameters display on the AWI Bandwidth page:
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AWI Bandwidth page

Three settings found on the AWI Bandwidth page—Device Bandwidth Limit, Device
Bandwidth Target, and Device Bandwidth Floor—help the PCoIP protocol use the
available network bandwidth effectively.

Device Bandwidth Limit

Enter the maximum bandwidth peak for hosts or clients. When configuring hosts, this
setting defines the bandwidth from the host to the client (e.g., graphics data). When
configuring clients, it defines the bandwidth from the client to the host (e.g., USB data).

The usable range of the device bandwidth is 1000 to 900000 kbps for Tera2 devices.

The PCoIP processor only uses the required bandwidth up to the Device Bandwidth
Limit maximum, and dynamically adjusts the bandwidth in response to network
congestion. Setting this field to 0 configures the PCoIP processor to use the maximum
rate available in the network at any time.

We recommend setting this field to the limit of the network connected to the client and
host.

Device Bandwidth Target

Enter the temporary limit on the network bandwidth during periods of congestion.
When the host or client detects packet loss, the device bandwidth is rapidly reduced to
this value, and then more slowly reduced below it. This allows for a more even
distribution of bandwidth between users sharing a congested network link.
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Device Bandwidth Floor

Enter the minimum bandwidth when congestion is present and bandwidth is required.
This allows you to optimize performance for a network with understood congestion or
packet loss. If the bandwidth is not required, the bandwidth used drops below the floor.

When configuring hosts, this setting defines the minimum bandwidth from the host to
the client (e.g., graphics data).When configuring clients, it defines the minimum
bandwidth from the client to the host (e.g., USB data).

A setting of 0 configures the PCoIP processor to reduce bandwidth to 1000 Kbps
during these network impairments. You should have a good understanding of the
network topology before setting this to a non-zero value.

Info: PCoIP Algorithm behavior
The firmware implements a slow-start algorithm that increases the bandwidth
used until the required bandwidth is reached, network congestion is detected,
or theDevice Bandwidth Limit is met. It begins at the lesser of theDevice
Bandwidth Limit and 8000 Kbps, and increases the bandwidth used within
seconds. The slow-start algorithm allows a graceful session startup for low
bandwidth scenarios (e.g., WAN scenarios). After initiating a PCoIP session,
usersmay temporarily notice low bandwidth video artifacts as the algorithm
ramps up bandwidth use.

Uyou can avoid the slow-start algorithm by setting the bandwidth floor higher
than 8000 kbps, but you must ensure your network capacity is large enough or
you will create severe session degradation.

Caution: Bandwidth Floor incorrectly configured
If the bandwidth floor is accidentally set above the actual capacity of the
network, then massive packet loss will result since the device will never drop it's
active limit below the floor. This will result in severe session degradation. This is
why care must be taken when choosing an appropriate bandwidth floor.

Configuring Image Quality
If desired, you can adjust the quality of the images you see during PCoIP sessions.
You can set image quality preferences from the AWI Image page. Image quality and
bandwidth settings help to determine the performance of your PCoIP deployment.
These settings will control the amount of PCoIP data that flows through your available
network bandwidth. Considerations for other network traffic should be made when
adjusting these settings. The default settings (40, 90, 0) have been found to be
beneficial for a wide variety of networks.
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AWI Image page

Note: Image quality settings apply to sessions with Tera2 zero clients
or PCoIP software clients
Image quality settings apply to sessions between Tera2 zero clients or
PCoIP Software Clients and PCoIP remote workstation cards.

Image Parameters

Parameter Description

Use Client Image
Settings

The client image settings only take effect in a PCoIP session
with a PCoIP zero client. This allows different PCoIP clients
with different settings to configure the optimal image settings for
network connections between them and the remote workstation
card. It is only advised to clear this checkbox and override the
image settings on the remote workstation card if one is unable to
modify the image quality settings on the client. One example is
with software clients which do not expose the image quality
settings to the end user.
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Parameter Description

Minimum Image
Quality

(default 40)

Enables you to compromise image quality and frame rate when
network bandwidth is limited. Some use cases may require
lower-quality images at a higher frame rate while others need
higher-quality images at a lower frame rate.

In environments where the network bandwidth is constrained,
reduce the number to enable higher frame rates. Increase the
number to enable higher image quality through lower frame rates
providing a perception-free quality. When network bandwidth is
not constrained, the PCoIP system maintains perception-free
quality regardless of theMinimum Image Quality parameter.

TheMaximum Initial Image Quality must be greater than or
equal to theMinimum Image Quality.

Maximum Initial
Image Quality

(default 90)

Decreasing the number reduces the network bandwidth peaks
caused by screen content changes, but produces lower quality
images. Increasing this value produces higher quality images but
also higher bandwidth peaks.

This parameter limits the initial quality on the first display frame
of a screen change. Unchanged regions of the image are built to
a lossless state regardless of this parameter.

TheMaximum Initial Image Quality must be greater than or
equal to theMinimum Image Quality.

Maximum Frame
Rate

(default 0)

Themaximum frame rate helps youmanagemultiple
PCoIP sessions over a single network link. This setting
determines the limit that your users can reach. Set this field to 0
to set no frame limit. If you set a value, a single user is limited to
that value. This helps to control the user experience for all your
users.
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Parameter Description

Disable Build to
Lossless

Clear this check box to retain the PCoIP protocol’s build-to-
lossless feature, where images continue to be refined in the
background until they reach a fully lossless state (that is,
identical pixel-for-pixel rendering when compared to the host
image source). This is the default (recommended) setting.

Warning: Selecting the Disable Build to
Lossless check box degrades images
Selecting the Disable Build to Lossless check box
degrades the images presented to the user. Don't
select this check box unless your administrator
decides that users don't require optimal image
quality to perform critical functions.

If you select this check box, the PCoIP protocol
rapidly builds the client image to a high quality
image that may be perceptually lossless, but is not
a fully lossless state. This may provide some
bandwidth savings, but is not recommended for
use cases that require images and desktop
content to be truly lossless.

Configuring Monitor Emulation
The Monitor Emulation page lets you enable or disable monitor emulation for the
video ports on your remote workstation. You can access this page from the
Configuration > Monitor Emulation menu.

Some PCs and workstations do not boot if a display is not attached. The monitor
emulation feature presents a generic display to ensure the boot process completes.
When a session is connected, the client display information is sent to the host. For
further details about Teradici's monitor emulation feature, see Monitor Emulation.

Info: Monitor Emulation option
If monitor emulation is performed in hardware for a device, the AWI
Configurationmenu will not have aMonitor Emulation option.
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AWI Tera2 Host Monitor Emulation Page

AWI Tera2 Host Monitor Parameters

Parameter Description

Enable Monitor
Emulation on Video
Port 1

When enabled, the host responds to all Display Data Channel
(DDC) queries, regardless of whether a PCoIP session is active.
If a session is not active, the host provides emulated DDC data.
If a session is active, the host provides actual DDC data
gathered from themonitor connected to the client's port 1
connector. The ports are mapped one-to-one and in sequential
order (e.g., client port 1 to emulated port 1, and so on).

When disabled, the host only responds to Display Data Channel
(DDC) queries when a PCoIP session is active and a client
display is attached.

Note: Enabling this field can help resolve problems where video
is not present at the client.

Enable Monitor
Emulation on Video
Port 2

This field affects DDC queries for the port 2 connector, and
provides functionality identical to that for the port 1 connector.

Enable Monitor
Emulation on Video
Port 3

This field affects DDC queries for the port 3 connector, and
provides functionality identical to that for the port 1 connector.

Enable Monitor
Emulation on Video
Port 4

This field affects DDC queries for the port 4 connector, and
provides functionality identical to that for the port 1 connector.
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Parameter Description

Enable Host Hot-Plug
Delay

When enabled, allows lengthier hot plug de-assert/assert profiles
on the host. Enabling this feature allows the host to resolve
black screen issues with certain Linux GPU driver timing
expectations.

Enable Accelerated
Monitor Emulation

When enabled, this property accelerates the delivery of EDID
information to host systems that boot up very quickly (e.g.,
faster than five seconds), causing blank screens on the remote
end. Typically, these are systems with solid-state drives
(SSDs).

Configuring Time Settings
The Time page lets you configure Network Time Protocol (NTP) parameters to allow
the host event logs to be time-stamped based on NTP time.

Info: Time Parameter Limitations
l If the host is configured for DHCP and the DHCP server provides an NTP
server address, this address will override anymanually configured NTP
server. It will also enable NTP if it is disabled.

l The host does not get time zone or Daylight Saving Time (DST) information
from the NTP server.

You can access this page from the Configuration > Time menu.
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AWI Time Page

Tip: Time stamps in event logs
To simplify system troubleshooting, set the NTP parameters to allow user
events to correlate with the relevant diagnostic event log entries.

AWI Time Page Parameters

Parameter Description

Current Time Displays the time based on the NTP.

Enable NTP Enable or disable the NTP feature.

Identify NTP Host by Select if the NTP host is identified by IP address or by fully
qualified domain name (FQDN). If NTP is disabled, this field is
not required and is not editable. If you enter an invalid IP address
or DNS name, a message appears to prompt you to correct it.
The parameter depends on which method you choose.

l IP Address: Shows the NTP Host IP address
l FQDN: Shows the NTP Host DNS name

NTP Host Port Configure the port number of the NTP server. The default NTP
server port value is 123.

NTP Query Interval Configure the query interval. The first field is for the interval
period and the second field is for the time unit in minutes, hours,
days, or weeks.

Time Zone Select the local time zone.

Enable Daylight
Savings Time

Enable or disable the automatic adjustment for Daylight Saving
Time (DST).

AWI Initial Setup Page
The AWI's Initial Setup page contains the audio, network, and session configuration
parameters that you must set before a pcoip endpoint can be used. This page helps to
simplify initial setup and reduce the time for new users to establish a session between
a PCoIP client and PCoIP Remote Workstation Card.

If configured in the firmware defaults, the Initial Setup page appears the first time you
log in. After you click Apply, the Home page appears for subsequent sessions unless
the firmware parameters are reset.
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Note: Complex environments require further configuration
More complex environments that use host discovery or endpoint management
systems require further configuration than is available on the Initial Setup page.
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PCoIP Remote Workstation Card
Security Overview
PCoIP remote workstation cards are easy to manage devices that offer a rich user
experience and allow for ultra-secure data transfer. They are available in a variety of
form factors from a number of trusted OEMs. With embedded hardware support for
PCoIP from the TERA chipset by Teradici, PCoIP remote workstation cards are a
natural choice wherever security and performance are critical. The security section of
this manual contains configuration options that affect the security of the PCoIP remote
workstation card.

Data Control
When control and lockdown of sensitive data are a primary objective, PCoIP remote
workstation cards enable an environment where no application data ever leaves the
host PC. The host PC sends only encrypted PCoIP data to the PCoIP client where no
sensitive application data is ever processed or stored. In a PCoIP session the data is
separated into management channel and media (display data, USB data, and audio
network traffic) stream, both encrypted.

Encryption
PCoIP remote workstation cards support the following encryption types.

TLS Security Mode for session negotiation security.

l Maximum Compatibility: TLS 1.1 or higher with RSA keys
l Suite B: TLS 1.2 with Suite B-compliant 192-bit elliptic curve encryption

PCoIP Data Encrypiton Ciphers for session security:

l AES-128-GCM
l AES-256-GCM

To establish a PCoIP session the PCoIP Remote Workstation Card exchanges
information with several services while connecting to endpoint managers, connection
managers, and PCoIP clients. These encryption methods are discussed in Security
Cipher Suites on page 74.
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802.1x Network Authentication
PCoIP Remote Workstation Cards support 802.1x network device authentication using
EAP-TLS certificates. With 802.1x network authentication, all network end devices
must be authenticated before they are granted access to the network. This is a typical
method of device authentication for high security environments, providing an
additional layer of security beyond username and password credentials.

See Configuring 802.1x Network Device Authentication in the "How To" section for
instructions on how to configure PCoIP remote workstation cards for this type of
authentication.

Management Security Level
The PCoIP remote workstation card is set to the most flexible management state by
default settings. The lowest security setting enables the host be manually discovered
by an endpoint management tool and verified by its certificate fingerprint. To further
secure PCoIP remote workstation card management, two additional security level
options are available—Medium Security Environment and High Security Environment.
See About PCoIP Remote Workstation Card Management Security Levels on page 64
for further information.

Securing Your PCoIP Remote Workstation
Card
The security needs of your deployment are driven by your specific environment. You
can configure PCoIP Remote Workstation Cards to meet security requirements for a
range of scenarios, from high-security environments to trusted environments.

Securing your PCoIP Remote Workstation Card involves some or all of these tasks,
depending on your deployment needs:

l Peering to your Zero Client: Adding a peer-to-peer certificate allows for a secure
connection between dedicated remote workstation cards and zero clients. See
Peering Remote Workstation Cards to Zero Clients on page 70

l Uploading certificates to the PCoIP Remote Workstation Card   Depending on
the certificate checking mode you choose, you may have to upload server
certificates to the PCoIP Remote Workstation Card's certificate store. See
Uploading Certificates on page 67.

l Configuring the PCoIP Remote Workstation Card with an endpoint
manager   Configure your PCoIP Remote Workstation Card for either automatic
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or manual discovery by an endpoint manager. See About PCoIP Remote
Workstation Card Management Security Levels on page 64.

l Configuring 802.1x Network Device Authentication   Configure 802.1x network
device authentication for enhanced security. See Configuring 802.1x Network
Device Authentication on page 77.

l Configuring Access to Management Tools   Configure a PCoIP device
management tool from managing the PCoIP Remote Workstation Card, disable
administrative access to the PCoIP Remote Workstation Card's AWI, or force an
administrative password change the next time someone accesses the AWI. See
Configuring Access Settings on page 62.

Tip: You can access additional security functionality from the PCoIP
Management Console
You can configure security settings for multiple devices from the PCoIP
Management Console, as well as access additional AWI security settings such
as disabling the AWI. For more information, see the PCoIP®Management
Console 3.1 Administrators’ Guide .

Using an Endpoint Manager
An installed certificate is required to connect to an endpoint manager in medium or
high security levels; however, out of the box, the PCoIP remote workstation card‘s
local certificate store is empty and it can only connect using the low security level.

To deploy a system using medium or high security settings, you must stage the device
by connecting to an endpoint manager in low security mode and installing any
required certificates or installing the certificate from the AWI.

Once the certificate has been installed, you can connect using any security level.

In some deployments, administrators choose to remove administration of the PCoIP
remote workstation card by the PCoIP Management Console or AWI which adds an
additional layer of security.

Configuring Access Settings
The Access page lets you prevent the PCoIP device from being managed by the MC
(or any other PCoIP device management tool), and lets you disable administrative
access to the device's AWI. It also provides an option to force an administrative
password change the next time the AWI is accessed.

You can access this page from the Configuration > Access menu.
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AWI Access Page

These options can also be configured from the PCoIP Management Console 3.1 or
newer.

Caution: Enable at least one of the configuration interfaces
At least one of the device's management configuration interfaces (AWI or MC)
must remain enabled at all times. If you disable both management interfaces
you will lose the option to perform a software parameter reset should you want
to reuse the PCoIP remote workstation card in another deployment. You will be
left having to do a hardware jumper parameter reset to regain administrative
access to your PCoIP remote workstation card
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When the Disable Management Console Interface is checked, the management
console interface on the PCoIP remote workstation card cannot be accessed or
managed by the MC (or any other PCoIP device management tool).
When checked, the Disable Administrative Web Interface on the PCoIP remote
workstation card cannot be accessed or managed using the AWI.
The Force password change at next login causes the administrative password on the
AWI to be changed the next time the AWI is accessed. The new password may be
blank.

About PCoIP Remote Workstation Card
Management Security Levels
There are three available management security level settings in the PCoIP remote
workstation card: low, medium, and high. These settings determine whether the PCoIP
remote workstation card can be discovered by an endpoint manager, how an endpoint
manager can be discovered by the PCoIP remote workstation card, and also dictate
whether a certificate must be installed in the PCoIP remote workstation card for
discovery to succeed.

The management security level is configured on the Management page of the AWI
(see Configuring the Management State on page 37). Detailed instructions for allowing
discovery under most scenarios, including security level settings, are described in
Configuring Endpoint Management Discovery Methods on page 42.

The general implications of each security mode are summarized in the following table
and described in detail next.

Note: Discovery Mode definition
TheDiscoveryMode setting on theManagement page, described here,
configures how endpoint managers are discovered by the PCoIP remote
workstation card.

Discovery in this context does not refer to discovery of the PCoIP remote
workstation card by endpoint managers. For instructions on having an endpoint
manager discover your PCoIP remote workstation card, seeConfiguring
Endpoint Management DiscoveryMethods on page 42.
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PCoIP remote workstation card behavior in the three management security modes

Low Medium High

Automatic Manual Automatic Manual Manual

Can be discovered by endpoint
managers

Can automatically discover endpoint
managers using DNS

Can trust endpoint managers using
DNS or DHCP

Canmanually connect to endpoint
managers

Can trust endpoint managers using an
installed certificate

Low Security Mode
In low security mode, both automatic and manual discovery methods are available.
Certificates are not required in automatic manager discovery mode if the DNS server is
configured to provision the PCoIP remote workstation card with the URI of the
endpoint manager's bootstrap server and its certificate fingerprint.

In automatic discovery mode the PCoIP remote workstation card:

l can use DNS or DHCP to automatically discover endpoint managers.
l is discoverable by endpoint managers.
l can use DNS to trust the endpoint manager. DNS must be configured to
provision your endpoint with the URI and certificate fingerprint of the endpoint
manager’s bootstrap server.

Resource: DNS server configuration information
For details about how to configure your DNS server for automatic
discovery, see the PCoIP®Management Console 3.1 Administrators’
Guide.

In manual discovery mode:

l The endpoint must be manually configured with the endpoint manager’s
bootstrap server URI.

l The endpoint is discoverable by endpoint managers.
l The endpoint does NOT require an installed certificate to trust the endpoint
manager.
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Note: Certificates installed on the endpoint
If a certificate for the endpoint manager has not previously been installed
by an endpoint manager in the endpoints certificate store, one must be
installed by the endpoint manager or AWI. SeeUsing an Endpoint
Manager on page 62.

Medium Security Mode
In medium security mode, the PCoIP remote workstation card cannot be discovered by
endpoint managers. The PCoIP remote workstation card can discover endpoint
managers automatically or manually. Certificates are required in medium security
mode.

Note: Certificates installed on the endpoint
If a certificate for the endpoint manager has not previously been installed by an
endpoint manager in the endpoints certificate store, one must be installed by
the endpoint manager or AWI. SeeUsing an Endpoint Manager on page 62.

In automatic discovery mode the PCoIP remote workstation card:

l can use DNS or DHCP to automatically discover endpoint managers.
l is not discoverable by endpoint managers.
l must have an installed certificate to trust the endpoint manager.

In manual discovery mode the PCoIP remote workstation card:

l is not discoverable by endpoint managers.
l must be manually configured with the endpoint manager’s bootstrap server URI.
l must have an installed certificate to trust the endpoint manager.

High Security Mode
In high security mode, the discovery bootstrap phase is disabled. All settings must be
manually configured, and certificates are required.

Note: Certificates installed on the endpoint
If a certificate for the endpoint manager has not previously been installed by an
endpoint manager in the endpoints certificate store, one must be installed by
the endpoint manager or AWI. SeeUsing an Endpoint Manager on page 62.

l Cannot use DNS or DHCP automatic discovery

In manual discovery mode the PCoIP remote workstation card.
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l is not discoverable by endpoint managers.
l must be manually configured with the endpoint managers’ internal (and,
optionally, external) URI.

l must have an installed certificate to trust the endpoint manager.

About Certificates
Certificates can be used to trust endpoint managers at all security levels, but are
required when using medium or high security.

If a PCoIP Management Console certificate is required, you can use an issuer
certificate—either the root CA certificate, or the leaf certificate used to issue the PCoIP
Management Console’s public key certificate—or the PCoIP Management Console’s
public key certificate.

Related Information: PCoIP Management Console certificates
For complete information about PCoIP Management Console components,
including the Endpoint Bootstrap Manager and PCoIP Management Console
certificates, see the PCoIP®Management Console 3.1 Administrators’ Guide.

Customer peer-to-peer certificates can also be used to secure zero clients connecting
to remote workstation cards in your deployment. See Peering Remote Workstation
Cards to Zero Clients on page 70 and Uploading Certificates on page 67 for further
details on how to upload and apply peer-to-peer certificates.

Important: OCSP (Online Certificate Status Protocol)
OCSP (Online Certificate Status Protocol) is currently not supported on PCoIP
RemoteWorkstation Cards

Uploading Certificates
You can upload and manage your CA root and client certificates for PCoIP remote
workstation cards from the AWI's Certificate Upload page, shown next.
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AWI Certificate Upload Page

The maximum certificate size that you can upload from the AWI is 10,237 bytes. You
can upload up to 16 certificates providing you don't exceed the maximum storage size
of 98,112 bytes. The available storage field lets you know how much space is left in
the certificate store.

Note: Include all security information in 802.1x client certificate
802.1x is used to secure access to the network. The PCoIP protocol reads just
one 802.1x client certificate for 802.1x compliant networks. Make sure you
include all the required security information for your PCoIP devices in that client
certificate. For more information about uploading certificates, seeCertificate
management for PCoIP Zero Clients and RemoteWorkstation Cards (KB
15134-1063). For information on 802.1x certificate authentication, see
Configuring 802.1xNetwork Device Authentication on page 77.

Use the following when you use 802.1x authentication:

l 802.1x authentication requires two certificates—an 802.1x client certificate and an
802.1x server CA root certificate.

l The 802.1x client certificate must be in .pem format and contain a private key that
uses RSA encryption. If the certificate is in a different format, you must first
convert the certificate, including the private key, to .pem format before uploading
it.

l After uploading the 802.1x client certificate from the Certificate Upload page, you
must configure 802.1x authentication from the Network page. This entails
enabling 802.1x authentication, entering an identity string for the device,
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selecting the correct 802.1x client certificate from the drop-down list, and
applying your settings.

l The 802.1x server CA root certificate must be in .pem format, but should not need
to contain a private key. If the certificate is in a different format, you must convert
it to .pem format before uploading it. This certificate does not require
configuration from the Network page.

l Both the 802.1x client certificate and the 802.1x server CA root certificate must
be less than 10,238 bytes; otherwise, you will not be able to upload them. Some
certificate files may contain multiple certificates. If your certificate file is too large
and it has multiple certificates within, you can open the file in a text editor, copy
and save each certificate to its own file.

The following settings display on the AWI Certificate Upload page.

Certificate Upload Parameters

Parameter Description

Certificate filename Upload up to amaximum of 16 root and client certificates.

Available Storage: Amount of remaining storage space to add additional
certificates.

Uploaded Certificates This displays any uploaded certificates. To delete an uploaded
certificate, click theRemove button. The deletion process
occurs after the device is rebooted. To view the details of a
certificate, click theDetails button. These certificates appear as
options in theClient Certificate drop-downmenu on the
Network page.

Selected Peer-to-Peer
Certificate

This is a read-only field. It is linked to thePeer-to-Peer
Certificate field on theSession page.

802.1X Client
Certificate

This is a read-only field. It is linked to theClient Certificate field
on theNetwork page.

To upload a certificate to a PCoIP Remote Workstation Card:

1. From the AWI, select the Upload > Certificate.
2. Browse to the folder containing the certificate file. This file will have a .pem

extension.
3. Double-click the correct *.pem certificate file.
4. Click Upload.
5. Click OK to confirm that you want to proceed with the upload.
6. Click Continue.
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If the certificate uploads successfully, it will appear in the Uploaded Certificates list on
this page.

Peering Remote Workstation Cards to Zero
Clients
PCoIP Remote Workstation Cards can be peered (paired) to Zero Clients using
custom certificates to establish a PCoIP peer-to-peer connection that is unique to your
environment. This optional but recommended configuration allows for a more secure
connection then the default connection. The Remote Workstation Card must have a
root certificate and custom peer-to-peer certificate in their certificate store, and the
custom certificate which trusts the other device's selected peer-to-peer certificate must
be applied to the Peer-to-Peer Certificate field.

Related: Matching Zero Client configurations
Ensure you follow the peer-to-peer procedure on your Zero Client before
attempting to connect to it. See the PCoIP Zero Client Administrators' Guide
for details.

Important: Support for Peer-to-Peer Certificates
The peer-to-peer connection using certificates supports connections between
PCoIP Zero Clients and RemoteWorkstation Cards only.

To configure a peer-to-peer connection for a PCoIP Zero Client:

1. Upload your custom peer-to-peer certificate and your root certificate to your
Remote Workstation Card certificate store.
See Uploading Certificates on page 67 for details.

Tip: Zero Client Certificate
Ensure the desired trusted certificate is uploaded to the connecting Zero
Client

2. From the AWISession page select whether one client or multiple clients can
connect to your Remote Workstation Card.

l Select Accept Any Peer if you want any properly configured zero client to
be able to connect to your Remote Workstation Card.

l De-select Accept Any Peer and enter the Peer MAC Address of the
specific PCoIP Zero Client you want connecting to your Remote
Workstation Card.
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3. Select the TLS Security Mode option Suite B: TLS 1.2 with Suite B-compliant
192-bit elliptic curve encryption.

4. Select the correct Peer-to-Peer Certificate from the drop down list. (If it is not
displayed, you have not yet uploaded it to the certificate store)

5. Ensure the PCoIP Data Encryption Ciphers selections are compatible with the
settings on the PCoIP Zero Client.

6. Select Apply

High Security Settings Checklist
The following table provides a list of PCoIP remote workstation card security settings
that are frequently used in high security deployments. Your network administrator or
your security advisor must determine whether these settings are appropriate for your
own network environment. The most secure options are shown and are presented in
the order seen in the AWI.

PCoIP Remote Workstation Card Security Settings
PCoIP Remote Workstation Card Security Settings Checklist

Configuration
Category

Setting Name Setting

Initial Setup Accept Any Client False

Network Enable 802.1x Security True

Enable 802.1x
Authentication Identity

Enter the username configured for the
802.1x authentication.
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Configuration
Category

Setting Name Setting

Management Security Level High Security Environment - Bootstrap
phase disabled

Access Disable Management
Console Interface:

False

Warning: Disabling both the
Management Console and
AWI interfaces will make your hostcard
unmanageable unless a factory reset is
performed on the card

Disable Administrative
Web Interface:

True

Force password change
on next login:

True

Discovery Enable SLP Discovery False

SNMP Enable SNMP False

Session Accept Any Peer False

TLS Security Mode Suite B: TLS 1.2 with Suite B-
compliant 192-bit elliptic curve
encryption

Peer-to-Peer Certificate If a custom certificate is uploaded then
it will appear in thePeer-to-Peer
Certificate field and you will be able to
select it to be used for Zero Client to
RemoteWorkstation Card peer-to-peer
connections.

PCoIP Data Encryption
Ciphers

AES-256-GCM

Enable DSCP False
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Configuration
Category

Setting Name Setting

USB Authorized Devices Enter the USB rule, class, sub class
and protocol of authorized
USB devices bridged to the host PC to
gain access to the USB device.

Example: To allow USB access to HID
devices only, click Add New and
configure these settings:

Authorized:

Rule Type: Class
Device Class: Human Interface
Device Sub Class: Any
Protocol: Any

Unauthorized:

No unauthorization rules. Delete any
existing rules.When there are no rules,
the MC displays two radio buttons on the
Manage Profiles page. Select Erase the
device's existing USB unauthorizations
and replace them with an empty set.

Unauthorized Devices Enter the rule, class, sub class and
protocol of unauthorizedUSB devices
that are bridged to the host PC to
prevent access to the USB device
from the host PC.

Example: To allow USB access to all
devices except mass storage, click
Add New and configure these
settings.

Authorized:

Rule Type: Class
Device Class: Any
Sub Class: Any
Protocol: Any

Unauthorized:

Rule Type: Class
Device Class: Mass Storage
Sub Class: Any
Protocol: Any
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Configuration
Category

Setting Name Setting

Certificate Store Stores certificates for 802.1x and
certificates for secure connections
using themanagement protocol
allowingmanagement of the remote
workstation card.

Security Cipher Suites
Security cipher suites are sets of security algorithms or methods that help secure a
network connection. The PCoIP Remote Workstation Card exchanges information with
several services while connecting to endpoint managers, connection managers, and
PCoIP hosts. The various communication phases are described here together with the
set of cipher suites available to each phase. The topics include:

l Encrypting Browser Connections on page 74
l Encrypting Endpoint Discovery on page 75
l Encrypting Endpoint Manager Administration on page 75
l Security Cipher Suites on page 74
l Security Cipher Suites on page 74
l Encrypting PCoIP Session Negotiation with PCoIP Clients on page 76
l In-Session Encryption on page 76

Encrypting Browser Connections
You can manage PCoIP Remote Workstation Cards using a browser connection to the
AWI. These secure connections require Transport Layer Session TLS 1.2 compliant
browsers.

The following cipher suites (listed in order of preference) are used to secure a browser
connection to the AWI:

l TLS_RSA_WITH_AES_256_GCM_SHA384
l TLS_RSA_WITH_AES_128_GCM_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA256
l TLS_RSA_WITH_AES_128_CBC_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA
l TLS_RSA_WITH_AES_128_CBC_SHA
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Note: Recommended web browsers
Recommended web browsers are Firefox, Chrome, and Edge.

Encrypting Endpoint Discovery
PCoIP Remote Workstation Cards that are not managed by an endpoint manager,
such as the PCoIP Management Console, listen for incoming discovery requests.

When an endpoint discovery request from an endpoint manager is received by the
PCoIP Remote Workstation Card, communications between the endpoint manager
and the PCoIP Remote Workstation Card are established securely using one of the
following cipher algorithms:

l TLS_RSA_WITH_AES_256_CBC_SHA256
l TLS_RSA_WITH_AES_128_CBC_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA
l TLS_RSA_WITH_AES_128_CBC_SHA
l TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
l TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

Note: Minimum SSL version
There is a minimum required SSL version of TLS 1.1.

Encrypting Endpoint Manager Administration
Once an endpoint manager discovers a PCoIP Remote Workstation Card, it uses the
PCoIP Management Protocol to administer the endpoint. Communications between
endpoint managers and PCoIP Remote Workstation Cards use one of the following
cipher suites:

l TLS_DHE_RSA_WITH_AES_128_GCM_SHA256
l TLS_DHE_RSA_WITH_AES_128_CBC_SHA256
l TLS_DHE_RSA_WITH_AES_256_CBC_SHA256
l TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
l TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
l TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
l TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
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Note: Minimum SSL version
There is a minimum required SSL version of TLS 1.2.

Encrypting PCoIP Session Negotiation with PCoIP
Clients
After user authentication and resource selection, PCoIP sessions are negotiated
between the PCoIP client and the PCoIP Remote Workstation Card. These
negotiations take place before the PCoIP session is established, and are secured
using either Max Compatibility or Suite B cipher suites.

Maximum Compatibility cipher suites allow secure negotiation under a variety of
different cipher suites to offer flexibility for your network security requirements. The
Available negotiation cipher suites are:

l TLS_RSA_WITH_AES_256_GCM_SHA384
l TLS_RSA_WITH_AES_128_GCM_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA256
l TLS_RSA_WITH_AES_128_CBC_SHA256
l TLS_RSA_WITH_AES_256_CBC_SHA
l TLS_RSA_WITH_AES_128_CBC_SHA

Note: Minimum SSL version
These MaximumCompatibility security level cipher suites have a minimum
required SSL version of TLS 1.1.

Suite B security level cipher suite has a minimum required SSL version of TLS 1.2,
and applies only to Remote Workstation Card connections. It offers the greatest
security for negotiating session connections with a PCoIP client. The available suite B
cipher suite is:

l TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

In-Session Encryption
Once a PCoIP session has been negotiated and the connection established, PCoIP
clients enable the AES-128-GCM and AES-256-GCM session encryption algorithms.
One of these algorithms will secure all PCoIP communications during an active PCoIP
session with the most secure algorithm being selected if more than one algorithm is
enabled.

TER1206003/ 76

PCoIP® RemoteWorkstation Card Firmware 5.1 Administrators' Guide



Configuring 802.1x Network Device
Authentication
This section describes the components you need to configure 802.1x authentication,
and the detailed steps you need to follow to configure the authentication. The 802.1x
configurable options are listed in table form and show the default settings and where
the options can be managed from.

Preparing for 802.1x Configuration
Before you begin the configuration process, make sure you have these components:

l PCoIP Management Console 3.1 or later
l Windows Server 2008 R2 with AD DS (Active Directory Domain Services)
l Windows Server 2008 R2 with AD CS (Active Directory Certificate Services)
l Windows Server 2008 R2 with NPS (Network Policy and Access Services)
l A switch with 802.1x support configured

Configuring Devices for 802.1x Authentication
To configure 802.1x device authentication, complete the following steps:

1. Create a Client User on page 77.
2. Export the Root CA Certificate on page 78.
3. Create a Certificate Template for Client Authentication on page 78.
4. Issue the Client Certificate on page 79.
5. Export the Client Certificate on page 80.
6. Convert the Certificate Format from .pfx to .pem on page 81.
7. Import the Client Certificate into the Client User Account on page 82.
8. Import the Certificates to the Client Device on page 82.

Note: The following sections assume you are using Windows Server
2008 R2
The instructions in the following sections are based onWindows Server 2008
R2. If you are using a newer version of Windows Server, the stepsmay vary
slightly.

Create a Client User
In the Windows 2008 server, create a client user.
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To create a client user:

1. Log in to the Windows 2008 server.
2. Click Start > Administrative Tools > Server Manager.
3. Navigate to Roles > Active Directory Domain Services > Active Directory Users

and Computers > <domain.local> > Users.
4. Right-click Users, select New > User, and follow the wizard.

Export the Root CA Certificate
In the Certificate Authority (CA) server, export the root CA certificate.

To export the root CA certificate:

1. Log in to the Certificate Authority (CA) server.
2. Open a Microsoft Management Console window (for example,enter mmc.exe in

the Start menu search field).
3. From the console window, select File > Add/Remove Snap-in.
4. Add the Certificates snap-in, selecting Computer account and then Local

computer.
5. Click Finish, and OK to close the Add or Remove Snap-ins dialog.
6. From the console, select Certificates (Local Computer) > Trusted Root

Certification Authorities > Certificates.
7. In the right panel, right-click the certificate, and select All Tasks > Export.
8. Follow the wizard to export the certificate:

a. Select Base-64 encoded X.509 (.CER).
b. Click Browse, specify a name and location for the certificate, and then click

Save.

c. Click Finish, and then click OK.

Create a Certificate Template for Client Authentication
In the CA server, create a certificate template for client authentication.

To create a certificate template for client authentication:

1. From the CA server, click Start > Administrative Tools > Certification Authority.
2. Expand the tree for your CA.
3. Right-click Certificate Templates, and then click Manage.
4. Right-click the Computer template, and then click Duplicate Template.

TER1206003/ 78

PCoIP® RemoteWorkstation Card Firmware 5.1 Administrators' Guide



5. Configure the template as follows:

a. From the Compatibility tab, select Windows Server 2003.
b. From the General tab, enter a name for the template (for example, PCoIP

Remote Workstation Card 802.1x) and change the validity period to match
the organization’s security policy.

c. From the Request Handling tab, select Allow private key to be exported.
d. From the Subject Name tab, select Supply in the request.
e. From the Security tab, select the user who will be requesting the certificate,

and give Enroll permission to this user.
f. Click OK and close the Certificate Templates Console window.

6. From the Certification Authority window, right-click Certificate Templates, select
New, and then click Certificate Template to Issue.

7. Select the certificate you just created (that is, PCoIP Remote Workstation Card
802.1x), and then click OK. The template will now appear in the Certificate
Templates list.

8. Close the window.

Issue the Client Certificate
From the CA Web Enrollment interface for the certificate server, issue the client
certificate.

To issue the client certificate:

Note: Use Internet Explorer to log in to certificate server
Do not use any other browser except Internet Explorer to log into the certificate
server.

1. Using Internet Explorer on your local machine, go to your Certificate Authority
URL using the format https://<server>/certsrv/ (for example,
https://ca.domain.local/certsrv/).

2. Click Request a certificate and then click advanced certificate request.
3. Click Create and submit a request to this CA.
4. From the pop-up window, click Yes.
5. Fill out the Advanced Certificate Request form as follows:

a. In the Certificate Template section, select the certificate for clients (for
example, Remote Workstation Card 802.1x).

b. In the Identifying Information for Offline Template section, enter the account
name in the Name field. The other fields are not required.
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Caution: Enter the same name as the universal principal name
of the client user
The name you enter in theName field must be the universal principal
name (UPN) of the client user you created inCreate a Client User on
page 77 (for example, remoteworkstationcard@mydomain.local).

c. In the Additional Options section, set the Request Format to PKCS10.
d. If desired, enter a name in the Friendly Name field.
e. Click Submit, and then click Yes at the pop-up window.
f. From the Certificate Issued window, click Install this certificate.

Export the Client Certificate
From the machine on which you issued the certificate, export the client certificate.

To export the client certificate:

1. From the machine on which you issued the certificate, open a Microsoft
Management Console window (for example, enter mmc.exe in the Start menu
search field).

2. From the console window, select File > Add/Remove Snap-in.
3. Add the Certificates snap-in, selecting My user account.
4. Click Finish, and then click OK to close the Add or Remove Snap-ins dialog.
5. Select Certificates - Current User > Personal > Certificates.
6. In the right panel, right-click the certificate, and select All Tasks > Export.
7. Follow the wizard to export the certificate:

a. Click Yes, export the private key.
b. Select Personal Information Exchange - PKCS #12 (.PFX).
c. Enter a password for the certificate.
d. Click Browse, specify a name and location for the certificate, and then click

Save.
e. Click Finish, and then click OK.

8. Repeat Steps 5 to 7 again to export the PCoIP Remote Workstation Card
certificate, but this time without the private key (No, do not export the private
key), selecting the DER encoded binary X.509 (.CER) format instead of the
PKCS format.

9. Save this .cer file to a location where it can be accessed by the Windows 2008
server and imported into Active Directory.
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Convert the Certificate Format from .pfx to .pem
Using OpenSSL, convert the certificate format from .pfx to .pem.

To convert the certificate format from .pfx to .pem:

1. Download and install Windows OpenSSL from
http://www.slproweb.com/products/Win32OpenSSL.html. (The light version is
sufficient.)

2. Copy the .pfx client certificate file you saved above to the C:\OpenSSL-
Win32\bin directory.

3. Open a command prompt window, and enter the following command to convert
the certificate format from .pfx to .pem:
C:\OpenSSL-Win32\bin\openssl.exe pkcs12 -in <client_cert>.pfx
-out <client_cert>.pem -nodes
where <client_cert> is the name of the .pfx certificate file you saved to your local
machine.

4. When prompted, enter the password for the certificate file.
5. At the command prompt, enter the following command to create an RSA private

key file:
C:\OpenSSL-Win32\bin\openssl.exe rsa –in <client_cert>.pem –out
<client_cert>_rsa.pem
where <client_cert> is the name of the .pem certificate file you created in the
previous step.

6. In Notepad or any text editor:

a. Open both the original .pem file and the RSA .pem file you just created.
The RSA .pem file contains only an RSA private key. Because the PCoIP
Remote Workstation Card certificate requires its private key in RSA format,
you need to replace its private key with this RSA private key.

b. Copy the entire contents of the RSA .pem file (everything from -----BEGIN
RSA PRIVATE KEY ----- to -----END RSA PRIVATE KEY-----), and paste
it into the original .pem file, replacing its private key with this RSA private
key.

In other words, make sure that all the text from -----BEGIN PRIVATE KEY-
---- to -----END PRIVATE KEY (including the dashes) in the original .pem
file is replaced with the contents of -----BEGIN RSA PRIVATE KEY ----- to -
----END RSA PRIVATE KEY----- (including the dashes) from the RSA
.pem file

c. Save the original .pem file and close it. The certificate is now ready to be
uploaded to the PCoIP Remote Workstation Card.
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Import the Client Certificate into the Client User Account
In the Windows 2008 server, import the client certificate into the client user account.

To import the client certificate into the client user account:

1. Log in to the Windows 2008 server.
2. Click Start > Administrative Tools > Active Directory Users and Computers.
3. From the View menu, select Advanced Features.
4. Navigate to the user you created for the PCoIP remote workstation card.
5. Right-click the user, and select Name Mappings.
6. In the X.509 Certificates section, click Add.
7. Locate and select the PCoIP remote workstation card certificate you exported

that does not contain the private key (This file was saved to a network location in
step 9 of Export the Client Certificate on page 80.)

8. Make sure both identity boxes are selected. Click OK, and then click OK again.

Import the Certificates to the Client Device
From the device’s AWI, import the certificates.

To import the certificates into a profile using the PCoIP Management Console, see the
PCoIP® Management Console 3.1 Administrators’ Guide.

To import the certificates to a device using the AWI:

1. From a browser, log into the AWI for the PCoIP Remote Workstation Card.
2. From the AWI, select Upload > Certificate.
3. Upload both the Root CA certificate and the certificate with the private key, using

the Browse button to locate each certificate and the Upload button to upload
them.

4. From the OSD or AWI, select Configuration > Network
5. Select Enable 802.1x Security.
6. Click Choose beside the Client Certificate field.
7. Select the certificate with the private key, and then click Select.
8. Enter the identity name of the certificate. Typically, this is the universal principal

name (UPN) that appears after Subject: (for example,
remoteworkstationcard@mydomain.local).
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Note: Windows server may be configured to use the certificate’s
Subject, the Subject Alternative Name, or another field
For the identity name, your Windows server may be configured to use the
certificate’sSubject, the Subject Alternative Name, or another field. Check with
your administrator.

9. To enable greater 802.1x compatability for older switches on the network, select
Enable 802.1X Support for Legacy Switches. This setting is only available from
the AWI Network page.

10. Click Apply, and then click Reset.

Related: Getting more information about 802.1x
For more information about 802.1x, see the following Knowledge Base articles,
available from the Teradici Support Center :

l DoPCoIP Zero Clients support network authentication or 802.1x? (KB
15134-590)

l How to set upWindowsServer 2008 R2 as an 802.1X Authentication
Server (KB 15134-1245)

l PCoIP Troubleshooting Steps: IEEE 802.1xNetwork Authentication (KB
15134-928)

About USB Settings
From the AWI and Management Console 3.1 or later, you can configure access to the
host PC operating system for USB devices plugged into PCoIP zero client USB ports.
PCoIP Management Console, configurations are found in the PCoIP Management
Console Administrators' Guide.

Tip: USB device bridging
USB bridging to the host PC is supported by PCoIP Zero Clients

USB plug events are blocked in the Tera2 PCoIP Zero Client firmware by configuring
the Unauthorized Devices in its AWI. The PCoIP remote workstation card can also be
configured to block USB device access to the host PC for an additional layer of
security.

The USB permissions page is available on the PCoIP remote workstation card and
has a higher priority than the configurations on the PCoIP zero client and thus
overrides the client USB permissions. It is strongly recommended you only set the
USB permissions on the host when connecting to a PCoIP remote workstation card
from a zero client. The following rules apply:
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l If the host has permissions programmed (authorized and/or unauthorized), the
permissions are sent to the client. If the client has any unauthorized devices, they
are added to the host’s unauthorized devices and the consolidated list is used.

l If the host does not have permissions programmed, the client’s permissions are
used.

The factory defaults have no USB permissions configured on the host. The factory
defaults for the client USB permissions are 'any, any, any' (that is, authorized USB
devices).

The host USB permissions are only updated at the start of a PCoIP session. They are
authorized in the following order of priority (from highest to lowest):

l Unauthorized Vendor ID/Product ID
l Authorized Vendor ID/Product ID
l Unauthorized Device Class/Sub Class/Protocol
l Authorized Device Class/Sub Class/Protocol

Configuring USB Settings and Permissions
From the AWI, you can configure USB permissions to authorize certain USB devices
bridged to the host PC to access the host operating system or add an additional layer
of security by unauthorizing USB devices trying to access the host PC operating
system.

Configuring USB Permissions from the AWI
From the AWI USB permissions page, you can configure USB permissions and:

l authorize and unauthorize a list of USB devices based on ID or Class. You can
use wildcards (or specify any) to reduce the number of entries needed to define
all devices.

l configure devices that are bridged to the host that are allowed to access the host
PC operating system.

The following parameters display on the AWI Permissions USB page:
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AWI USB Permissions Parameters

Parameter Description

Authorized
Devices

Specify the authorized USB devices for the device:

Add New: add a new device or device group to the list. This allows USB
authorization by ID or Class:

l ID: The USB device is authorized by its Vendor ID and Product ID.
l Class: The USB device is authorized by Device Class, Sub Class,
and Protocol.

Remove: Delete a rule for a device or device group from the list.

Unauthorized
Devices

Specify the unauthorized USB devices for the device.

Add New: add a new device or device group to the list. This allows USB
devices to be unauthorized by ID or Class:

l ID: The USB device is unauthorized by its Vendor ID and Product ID
l Class: The USB device is unauthorized by Device Class, Sub Class,
and Protocol.

Remove: Delete a rule for a device or device group from the list.
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To configure USB settings:

1. From the AWI, select Configuration > USB.

AWI USB permissions page

2. From the AWI USB page, update the USB settings by selecting Add new and
configure the required parameters.
The parameters that display depend on whether you describe the device by
Class or ID.

Device class parameters
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Device ID parameters

3. Click Add.
4. Click Apply.

The following parameters display when you authorize or unauthorize USB device
parameters:

USB Authorized/Unauthorized Devices Parameters

Parameter Description

Add new When adding a new USB authorization or unauthorization entry, select one
of the following:

l Class: The USB device is authorized by its device class, sub-class,
and protocol information.

l ID:The USB device is authorized by its vendor ID and product ID
information.

Device Class This field is enabled whenClass is selected.

Select a supported device class from the drop-downmenu, or select Any
to authorize or unauthorize (disable) any device class.

Sub Class This field is enabled whenClass is selected.

Select a supported device sub class from the drop-downmenu, or select
Any to authorize or unauthorize (disable) any sub-class.

Note: If Any is selected as the device class, this will be the only selection
available.

Protocol This field is enabled whenClass is selected.

Select a supported protocol from the drop-downmenu, or select Any.

Note: If Any is selected as the device class or sub-class, this will be the
only selection available.

Vendor ID This field is enabled when ID is selected.

Enter the vendor ID of the authorized (or unauthorized) device. The valid
range is hexadecimal 0-FFFF.
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Parameter Description

Protocol ID This field is enabled when ID is selected.

Enter the product ID of the (authorized or unauthorized) device. The valid
range is hexadecimal 0-FFFF.
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Establishing a PCoIP Session to a
Remote Workstation Card
After successfully completing the installation steps, the PCoIP remote workstation card
will connect to the network when the workstation is powered on. By default, DHCP is
enabled on the remote workstation card to allow your DHCP server to assign an IP
address to the remote workstation card. If your network does not support DHCP, the
card's default IP address will be 192.168.1.100. The PCoIP remote workstation card is
configured to accept connections from any peer which will allow you to initiate a
PCoIP session from a PCoIP zero client, or software client. Finally the PCoIP Remote
Workstation Card TLS Security Mode is set to Maximum Compatibility: TLS 1.1 or
higher with RSA keys by default. This setting can be set to a more secure setting of
Suite B: TLS 1.2 with Suite B-compliant 192-bit elliptic curve encryption if your
connecting client has a compatible setting.

Tip: Session Security Setting
Ensure your PCoIP client has a matching session setting if you are having
issues connecting to the PCoIP RemoteWorkstation Card

When using a PCoIP software client, the IP address of the PCoIP remote workstation
card must be known. If using a PCoIP zero client, you have the option of using SLP
discovery. To use SLP discovery, it must be enabled. This setting is located on the
remote workstation card AWI Discovery page.

For information on how to configure a connection to a PCoIP Remote Workstation
Card using a Teradici PCoIP® Software Client or PCoIP® Zero Client, see the latest
Administrators' Guide for the client your are using, available from the Teradici support
site.

Info: Number of SLP Displayed Remote Workstation Cards
A PCoIP zero client configured to use SLP reports the first 10 responding
PCoIP remote workstation cards. If you do not see the MACor IP address of
your card, you can try reconnecting the zero client to the network after
powering down some or all of the host PCs that you do not want to connect to
and see if your IP/MACaddress is displayed.
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Tip: Record Your MAC Address
Service Location Protocol (SLP) can dynamically discover devices without
requiring prior knowledge of their whereabouts on the network. SLP host
discovery requires the zero client and host PC to reside on the same subnet.
You also need to know the IP address and/or MACaddress of the remote
workstation card so you can select it from the list of available hosts. In addition,
the remote workstation card must be configured to accept any peer or to accept
the specific MACaddress of the zero client. If the card was previously
configured, you can configure this from the PCoIP RemoteWorkstation Card
AWI. SeeConfiguring a Session on page 47 page.

Connecting Remotely
PCoIP sessions between clients and hosts can operate in a wide area network (WAN)
that traverses the Internet. You can connect clients and hosts remotely using the
following methods:

l Configuring network address translation (NAT) devices at both ends to
implement the necessary IP address and port translation. This method applies
only to Tera2 devices that employ UDP-encapsulated IPsec ESP encryption.

l Setting up a VPN to connect two trusted networks over an intermediate untrusted
network.

l Using the PCoIP Management Console to remotely manage connections using a
reverse proxy. This type of deployment is described in the Remote Endpoint
section of the PCoIP Management Console Administrators' Guide.

The scenarios listed below describe some common ways you can connect PCoIP
endpoints remotely.

l Scenario 1: Connecting a zero client to a remote workstation card (WAN).
l Scenario 2: Connecting a zero client to a remote workstation card over a
hardware VPN (WAN).

Zero Client to Remote Workstation Card (WAN)
Tera2 zero clients and remote workstation cards use UDP-encapsulated IPsec format.
Because this encapsulation type supports IP address and port number translation, it is
not necessary to set up a VPN when these devices connect remotely. To connect
devices with earlier firmware versions, see Zero Client to Remote Workstation Card
Using a Hardware VPN.
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Info: Host Software assumption
All remote workstation card scenarios assume you have the PCoIP host
software installed on the host PC. For details, please see PCoIP® Host
Software for WindowsUser Guide . Please refer toConnection Prerequisites
for other conditions that may apply.

Info: Example IPs
The IP addresses in the following figures are intended as example addresses
only.

The figure below shows a Tera2 zero client establishing a PCoIP session with a
remote workstation card over a WAN.

Tera2 Zero Client to Remote Workstation Card (WAN)

You can also have multiple zero clients and remote workstation cards connected
behind NAT devices, as shown in the next figure.

Info: NAT
In this scenario, an enterprise-level NAT device is required in both the source
and destination networks.
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Remote PCoIP Sessions with Multiple Tera2 Devices

To establish the connection:

1. For the first scenario: Configure the enterprise NAT device to redirect TCP/UDP
port 4172 to the remote workstation card.
For the second scenario:

l Configure the source enterprise NAT device (203.0.0.1) to translate IP
address and ports as follows:
192.168.0.1:4172 to 203.0.0.1:4172
192.168.0.2:4172 to 203.0.0.1:4173
192.168.0.3:4172 to 203.0.0.1:4174

l Configure the destination enterprise NAT device (144.0.0.1) to translate IP
addresses and ports as follows:
144.0.0.1:4172 to 10.0.10.1:4172
144.0.0.1:4173 to 10.0.10.2:4172
144.0.0.1:4174 to 10.0.10.3:4172

2. From the zero client's AWI:

l Configure the Direct to Host session connection type, and enter the IP
address of the destination enterprise NAT device.

3. From the remote workstation card's AWI:

l Configure the Session connection.
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4. On your firewall or router, allow both TCP and UDP traffic on the ports you have
configured in your NAT devices (4172+).

5. Start a PCoIP session.
6. If necessary, adjust bandwidth and image parameters on both the host and client

to optimize performance.

For more information on how NAT applications work with PCoIP, please log in to the
Teradici KB 1623 and KB 1487.

For information on optimizing networks for WAN connections, please log in to the
Teradici Support Site and see the following Knowledge Base topics:

l Packet size (MTU) settings: KB 15134-40
l Bandwidth settings: KB 15134-242, KB 15134-88
l Image settings: KB 15134-28, KB 15134-51
l Windows desktop experience optimization: KB 15134-242, KB 15134-880

Zero Client to Remote Workstation Card via
Hardware VPN (WAN)
The figure below shows a PCoIP session between a zero client and remote
workstation card over a hardware VPN.

Hardware VPN – Zero Client to Remote Workstation Card (WAN)

A VPN is necessary when connecting the following PCoIP endpoints over the Internet:

l Tera2 zero client to a Tera2 remote workstation card when the installed firmware
in these devices is prior to release 4.1.0

l Tera2 zero client to a Tera2 remote workstation card when the enterprise NAT
device/gateway cannot implement the required IP address and port translation

To establish the connection:
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1. At the home network, install a VPN endpoint device (e.g., a router) and establish
a VPN session between the endpoint device and the enterprise VPN gateway.
For information on how to set up the VPN, please see the documentation for your
device.

2. Configure the enterprise VPN gateway/firewall/NAT device to allow IPsec ESP
traffic, and also traffic on UDP port 4172 for the PCoIP data stream and on TCP
port 4172 for the TCP handshake.

3. From the zero client's AWI:

l Configure the Direct to Host session connection type, and enter the IP
address of the remote workstation card.

l Configure the address of the home VPN endpoint device as the default
gateway.

l Set the packet MTU to be less than or equal to the largest size supported
by the VPN tunnel.

4. From the remote workstation card's AWI:

l Configure the Session connection type.
l Set the packet MTU to be less than or equal to the largest size supported
by the VPN tunnel.

5. Start a PCoIP session.
6. If necessary, adjust bandwidth and image parameters on both the host and client

to optimize performance.

For information on optimizing networks for WAN connections, please log in to the
Teradici Support Site and see the following Knowledge Base topics:

l Packet size (MTU) settings: KB 15134-40
l Bandwidth settings: KB 15134-242, KB 15134-88
l Image settings: KB 15134-28, KB 15134-51
l Windows desktop experience optimization: KB 15134-242, KB 15134-880
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'How To' Topics

Upload a Firmware Release to a Remote
Workstation Card
To upload a firmware release to a PCoIP Remote Workstation Card:

1. Ensure the host PC is in an idle state (i.e., that all applications are
closed).

2. Log into the host's AWI.
3. From the Firmware Upload page, browse to the folder containing the

firmware file. This file will have an ".all" extension.
4. Double-click the correct "*.all" firmware file.
5. Click Upload.
6. Click OK to confirm that you want to proceed with the upload. The

operation may take a few minutes. When completed, the AWI page
displays two buttons—Reset and Continue.

7. Click Reset.
8. Click OK.
9. Power off and then power on the host PC. It is necessary to power off

(not just restart) the PC or workstation in order for the changes to take
effect on the remote workstation card.

Related: Large deployments
Administrators wanting to apply new firmware to a large number of
PCoIP remote workstation cards should consult the managing profiles
section of the PCoIP Management Console Administrators' Guide.

Displaying Processor Information
The Processor field on the AWI Home page for a host or client displays the
name of the device's processor, or chipset.
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Processor Information on AWI Home Page

The processor family name displays on the AWI Version page for a host or
client.

Processor Family Information on AWI Version Page

Configuring Syslog Settings
You can configure syslog settings for a host or zero client from the device's
AWI, or you can use the MC to configure settings for a device profile. Both
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methods are shown below. Configuration involves entering the IP address or
fully qualified domain name (FQDN) for the syslog server, and then specifying
the port number and facility to use when sending messages to the syslog
server.

Teradici uses UDP to send syslog messages to a centralized syslog server.
Because most servers use port 514 for incoming messages, Teradici
recommends you configure port 514 (the default) as the syslog port to use.
However, you can use a different port as long as the syslog server is set to
receive syslog messages on the same port as the device is set to send them.

Teradici also uses "19 – local use 3" as the default facility under the
assumption that this facility is not commonly used. If it is being used, you can
select a different facility.

Note: Cisco IOS devices, CatOS switches, and VPN 3000 concentrators use
the “23 – local use 7” facility. Cisco PIX firewalls use the “20 – local use 4”
facility.

Note: Ensure that your syslog server can handle the volume of messages sent
by a zero client. With some free syslog servers, messages can become lost if
the volume is too great.

Setting up Syslog from the AWI
Syslog settings in the AWI are located in the Event Log page. To configure
syslog settings from the AWI for a single device:

1. From an Internet browser, enter the IP address of the PCoIP zero client
or host.
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2. Select the Diagnostics > Event Log menu to display the Event Log
page.

3. Check Enable Syslog, and then select whether you want to identify the
syslog server by its IP address or fully qualified domain name (FQDN).

4. Enter the IP address or FQDN of the syslog server.
5. If the syslog server is configured to receive data on a port other than 514,

enter this port number.
6. If you wish the device to use a facility other than the default, select it from

the Syslog Facility drop-down list.
7. Click Apply.
8. At the Success page, click Continue.

Setting up Syslog from the MC
Syslog settings in the MC are located in the MC's Event Log page. To
configure syslog settings from the MC for a device profile:

1. From an Internet browser, enter the IP address of the MC.
2. Select the Profiles tab.
3. From the Profile Management page, click the Set Properties link for the

desired profile.
4. Expand the Event Log Control category, and then click the Edit

Properties link.
5. Enable Syslog Server Hostname, and then enter the IP address or

FQDN of the syslog server.
6. Enable Syslog Server Port, and then enter the port number used by the

syslog server for incoming messages. The device will use this port to
send messages.

7. Enable Syslog Facility Number, and then enter the facility level number
that the device will use when sending messages.

8. Click Save.

Note: You must enter a value in both the Syslog Server Port and Syslog
Facility Number fields.
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Technology Reference

Local Cursor and Keyboard
Local cursor and keyboard is a feature of the PCoIP Host Software that
improves usability for PCoIP sessions operating over WAN connections
(latency > 40 ms). When enabled, it allows the zero client to terminate input
from the mouse and keyboard, and to draw the cursor on the attached display
(s).

For more information about this feature and instructions on how to enable it,
please see PCoIP® Host Software for Windows User Guide.

Monitor Emulation
Teradici's monitor emulation feature for PCoIP Remote Workstation Cards
presents a generic display to ensure the boot process completes. It is intended
to alleviate issues related to graphics cards that do not enable Display Port or
DVI ports when no monitor is detected and/or do not honor hot plug events.
These issues can occur during initial BIOS/OS boot or at some time after a full
OS boot.

Enabling monitor emulation will provide the motherboard/GPU BIOS, OS, and
GPU software driver a valid EDID. In general, the firmware will respond with
the last connected monitor EDID when monitor emulation is enabled. If no
display has been connected to a port since the device was factory
programmed, a default EDID is used. The default monitor definitions shown
below.

Monitor Name TERA DEFAULT
Manufacturer ID XXX
Monitor Serial Number 000000000000

Established Timing Supported

640x480@60Hz (IBM,VGA)

800x600@60Hz (VESA)

1024x768@60Hz (VESA)
Standard Timing Supported 1280x1024@60Hz
Native Resolution 1024x768@60Hz

Monitor Range Limits Description

Min Vertical Freq – 50 Hz

Max Vertical Freq – 75 Hz

Min Horiz. Freq – 30 KHz

Max Horiz. Freq – 82 KHz

Pixel Clock – 140MHz
EDID Revision 1.4
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Note: Disable monitor emulation
This feature can be disabled to prevent GPUs from driving unwanted
display outputs. When in session, the true hotplug/display state is only
bridged from the client if the Teradici host software is installed. This
implies that a GPUmay drive emulated ports with a video signal, even
if the port on the client does not have an attached display.

PCoIP Software Session Variables
The PCoIP software session variables in Microsoft's Group Policy Object
(GPO) editor let you configure users' desktops with a collection of parameters
that affect PCoIP sessions with soft hosts. These variables are defined in a
GPO administrative template file called pcoip.adm, which is located on the
View Connection Server installation directory (\\”servername”\c$\Program
Files\VMware\VMware View\Server\extras\GroupPolicyFiles\pcoip.adm).

You can enable and configure PCoIP software session variables in either the
Group Policy Object editor's PCoIP Session Variables > Overridable
Administrator Defaults list to allow users to override settings or the PCoIP
Session Variables > Overridable Administrator Defaults list to prevent users
from overriding settings.

Note: For large environments, you can apply pcoip.adm to a Windows Active
Directory organizational unit (OU) or to a machine that you are configuring as
a template for a desktop pool. For further details, see "VMware View 5 with
PCoIP Network Optimization Guide" from the VMware Documentation
website.

For instructions on how to load the PCoIP session variables template to a
virtual machine's GPO editor, please see KB 1085 in the Teradici Support
Site. For detailed information on each PCoIP session variable, see KB 15134-
348.

PCoIP Packet Format
PCoIP is a real-time technology that uses UDP as the transport-layer protocol.
PCoIP supports two encryption types—UDP-encapsulated ESP and native
IPsec ESP. An unencrypted PCoIP transport header field is also present for
devices with firmware 4.1.0+ installed and/or for scenarios using View 5.1+.
The PCoIP transport header allows network devices to make better QoS
decisions for PCoIP traffic.

Note: TCP/UDP port 4172 is the Internet Assigned Numbers Authority (IANA)
port assigned to the PCoIP protocol. UDP port 4172 is used for the session
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data, and TCP port 4172 is used for the session handshake. For more
information about TCP/UDP ports that are used for PCoIP technology, see KB
15134-114 in the Teradici Support Site.

UDP-encapsulated ESP Packet Format
UDP-encapsulated ESP is the default packet format for Tera2 devices with
firmware 4.1.0 installed. It is also used for Tera1 devices with firmware 3.x+
installed that connect remotely via a View Security Gateway.

The UDP-encapsulated ESP packet format is illustrated in the figure below.
This figure also shows the location of the PCoIP transport header in a UDP-
encapsulated ESP packet.

UDP-encapsulated ESP Packet Format

IPsec ESP Packet Format
IPsec ESP encapsulation is the default packet format for direct connections
that involve a Tera1 zero client and/or Tera1 remote workstation card.

The IPsec ESP packet format is illustrated in the figure below. This figure also
shows the location of the PCoIP transport header in an IPsec ESP packet.

IPsec ESP Packet Format

Syslog
The syslog protocol is a standard for logging program messages to a
database. It is commonly used to monitor devices that do not have a large
amount of storage capacity, such as networking devices, ESX servers, Zero
Clients, and PCoIP Remote Workstation Cards. Using syslog for logging
allows you to centralize the storage of log messages and to capture and
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maintain a longer history of log data. It also provides a set of tools to filter and
report on syslog data.

Syslog messages include a facility level (from decimal 0 to 23) that indicates
the application or operating system component that is generating the log
message. For example, a facility level of "0" indicates a kernel message, a
facility level of "1" indicates a user-level message, and a facility level of "2"
indicates a message from a mail system. Processes and daemons that have
not been explicitly assigned a facility may use any of the eight "local use"
facilities ("16 – local use 0" to "23 – local use 7") or they may use the "1 – user-
level" facility. Facilities allow for easy filtering of messages generated by a
device.

Syslog messages are also assigned a severity level from 0 to 7, where a
severity level of "0" indicates an emergency panic condition and a severity
level of "7" indicates a debug-level message useful to developers but not for
operations.

See Configuring Syslog Settings in the"How To" section for information on
how to configure syslog from the AWI and MC.
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